User Guide

This guide explains how to access, search, list and play back phone calls, how to share and publish media and how to work with Cisco
phones.

Accessing the web interface

The Verba System can be securely accessed through a standard web browser with a user identity.

* Login

® Four eyes login
® Signout

® Locking users

Web interface layout

The Verba Web Application uses a common screen layout throughout the application.

® Body
® Header and menu
® Menu structure

® Updated menu structure in Verba 9

Searching conversations

The conversation search page can be accessed through the Conversations \ Search menu.

Reusing search criteria - saved queries

Search fields

Search filter operators

Special search modifier characters

Searching in IM conversations and voice transcripts

Conversation lists and actions

Users can search for recorded conversations, and the search results can be displayed through conversation lists.

Conversation fields

Conversation list layout

Conversation list navigation bar

Delete conversations

Downloading a single media file

Get direct link

Mark conversations as Protected

Metadata columns on conversation lists
Ongoing conversations

Playback and download multiple records simultaneously
Playing back recorded conversations
Presentation of complex conversation scenarios
Private conversations

Right click options on conversation lists
Sending an email

Silent monitoring ongoing conversations
Timeline View

Conversation details

Detailed information is shown for each recorded conversation on the call details screen.



® Adding metadata
® Conversation participant list

® Right click options

Participant sets

Web-based media player and viewer

The Verba media player and viewer is a feature-rich multimedia tool that supports an easy in-depth analysis of media recordings.

® Using the media player
® Using conversation markers

Verba Offline Player

® |nstalling a Windows Certificate for the Verba Offline Player
® Troubleshooting the Verba Offline Player

Sharing and publishing conversations

The recording system provides a secure and traceable way to share recordings among various members of your organization.

Sharing conversations
Managing shared items
Accessing shared conversations
Verba Publishing Server

Using the Cisco IP phone service

Many convenient features of the Verba System are available from Cisco IP phones.

Adding a tag to a conversation

Adding markers to an ongoing conversation

Flagging a conversation as Important

Flagging a conversation as private

Login to the Verba Phone service

Recording an ongoing conversation or the most recent conversation

Sending emails
Silent monitoring and whisper coaching

Desktop recorder user interface

Dial-in user interface

Using the Lync 2010, 2013 and Skype for Business extension for conference call
recording

Agent View

User Information




Accessing the web interface

Web access with login

The Verba System can be securely accessed through a standard web browser with a user identity.

The following HTTP address (URL) must be entered into the address field:

http://ServerNameorIPAddress/verba

ServerNameorlPAddress is the Verba Media Repository server name or IP address. Please contact the network administrator if the server
name or P address is not known.

HTTP IN 9.6 AND LATER

HTTP connection is by default not available, and automatically redirected to HTTPS. If HTTP connection is required, it can be re-enabled by
editing the file at Program Files\Verba\tomcat\conf\context.xml and commenting out the following line

<Val ve cl assName="cat.inspiracio.catalina.HttpsVval ve" />

When Verba is configured to use the Secure Sockets Layer (SSL - HTTPS) protocol, the following address shall be entered into the address
bar to access the web interface:

https://ServerNameorIPAddress/verba

(® Verbaweb interface shall be run on the supported web browsers only! Using other web browsers may result in missing pages,
missing parts of pages, and non-functional pages.

© The Verba user interface may be accessed quickly by adding the index page to the "Favorites" list of the browser after the first
run. By doing so the server address will be populated automatically at every start.

Web access with Single sign-on (SSO) authentication

The Verba web application supports single sign-on authentication, that is a user has to provide login credentials only one time, from then
on authentication is done in the background using Microsoft Windows Domain authentication information. Practically, when a user is
logged into the Windows Domain on the PC, they can access the web application without authenticating again.

In order to access the web interface with SSO, use the following URL:



http://ServerNameorIPAddress/verba/sso

When Verba is configured to use the Secure Sockets Layer (SSL - HTTPS) protocol, the following address shall be entered into the address
bar to access the web interface:

https://ServerNameorlPAddress/verba/sso

Access control

Login

Four eyes login
Sign out
Locking users



Login

Users can sign in to Verba in two different ways. They may either enter their Verba credentials, stored in the Verba database, or may enter
their Active Directory domain credentials.

Using Verba credentials

The login screen appears after pointing the web browser to the Verba Web Application.

verba

Administrator

Four eyes login

Meed help?

Type the user account name into the Login ID field (not case sensitive) and enter the unique password in the Password (case sensitive)
field, then press the Sign In button.

Contact the system administrator, if no login name and password was provided to you!

Should the user enter incorrect credentials, the login page displays the Wrong login credentials! error message.

Using Active Directory (Windows) domain credentials

Users can use Single Sign On with Active Directory in two different ways. When SSO is enabled in the system, a different login page is
displayed.

Automatic sign-in

When this option is enabled in the server configuration, then if the basic Web Application URL is used ("hostname/verba" or "IP address/
verba"), Verba will automatically redirect the user to authenticate in the Active Directory.

If the user is already logged in with his/her domain credentials, then they will automatically gain access to the Verba web interface and not
additional interaction is required.

Otherwise, the system will prompt for a username/password combination.



Windaows Security >

iexplore

Connecting to nenyuljhozza.verbamant.local.

‘ john.doe ‘

Domain: VERBALAES

|:| Remember my credentials

More choices

oK Cancel

Another URL can be used to avoid automatic redirection to AD ("hostname/verba/login.do" or "IP address/verba/login.do"). In this
case, the following login screen is displayed.

verba

Sign in with Windows Single Sign On

Sign in with User Name and Password

MNeed help?
The software is licensed to: Stark Industries
iersion: 9.0.0.5293
() Copyright Verba Technologies Ltd. 2000-2017. All ights resenved

When the Sign in with Windows Single Sign-On option is selected, users will be redirected to AD and the procedure described above
applies.

Manual sign-in

For manual sing-in the URL shown above ("hostname/verba/login.do" or "IP address/verba/login.do") should be used. Then upon
selecting the Sign in with User Name and Password option, the user is taken to the following page.



verba

& john.doe

Meed help?

Enter the username to make the system enable the password field.

verba

& john.doe

L Four eyes login

Sign in with my Verba Account

Sign in with my Windows Account

Meed help?

The Sign in with my Verba Account button will try to sign the user in based on the information available in the Verba database, as
described in the Login with Verba credentials section at the top.

The Sign in with my Windows Account button will send the credentials to the Active Directory and will sign the user in if the AD returns a
positive response.

©® Foureyes login with domain credentials can be used on this page.



Four eyes login

Overview

The four eyes principle is an important security concept in certain industries for certain business processes that require approval from
two persons before approval for a single business transaction, for example, log in. The transaction may be continued only on condition
both approvers have signed off the process.

Although the effectiveness of this two-tier approval process relies upon the ability, integrity and, diligence of the individuals involved, the
damages of a potential inadequate approval may be mitigated, because a second person is always involved in the final approval process.

With this in mind, it becomes evident that when a business process containing four-eyes principle constraints is automatized, the machine
must guarantee that two independent users perform the approval steps. In other words, if User A approves one of the approval steps, the
automation must make sure that user A is excluded from the subsequent approval step.

Configuring the Verba four eyes policy

With Verba, it is possible to define an observer user and/or an observer group for each user created in the recording system. If an observer
user is defined for a user, the user can only log in with the observer user login information besides her/his original login information. In this
way, these types of users can only access the Verba web application with the personal presence of the observer user. The same mechanism
is applied when an observer group is defined (any member of the observer group can be an observer user). This is an optional security
feature of the Verba system. For detailed information on user configuration, see Find and List Users.

Login with four eyes policy

To add the login information of the observer user, just select the checkbox next to the password input field.

verba

Password:  [RTCERTSIN W -

“Login

* Click the check box to enable four eyes login!

The software is licensad to: Verba Technologies
Serial Number: MNRHQ4DK-OO5SWDFLO-GEFQOX5K4I
Version: 5.0.0281

]

{c) Copyright Verba Technologies, LLC. 2000-2010. All rights reserved.

ment and may be used or copied only in
o ent. It is against the law
woe ifically allowed in the license agreement. Mo
his publication may be reproduced, stored in a retrieval system, or transmitted in
rm or by any means, electronic, mechanical, photocopy, recording, or otherwise,
without the prior written permissio Verba Technologies, LLC.

If the provided credentials are not valid, no error message is displayed; the login page is displayed again as part of the security design of
the system.


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816692/Find+and+List+Users

Sign out

When work is completed in the Verba system, it is advisable to sign out before closing the web browser application, by selecting the
Account management / Sign ogout menu item.

The login screen appears upon successful sign out, and the browser window can be safely closed.

Follow the instructions described in the previous section to log in again to Verba.



Locking users

The Verba System allows the system administrator to lock down user accounts as well as automatic lockout after a predefined number of
invalid login attempts. By utilizing the following two parameters this function is fully configurable by the system administrator:

User Lockout Threshold: The user lockout threshold sets the number of invalid logon attempts that are allowed before a user is locked
out. When lockout controls are used, they should be set to a value that balances the need to prevent user cracking and the needs of users
having difficulty accessing their accounts.

The most common reason why users are not able to access their accounts is that they forget their passwords. If this is the case, several
attempts may be needed to log in properly.

The lockout threshold can be set to any value between 0 and 999. When the lockout threshold is set to zero, users will not be locked out on
invalid login attempts. Any other value sets a specific lockout threshold. Keep in mind that the higher the lockout value is, the higher the
risk that a hacker may be able to break into a system.

Reset User Lockout Threshold After: Every time a logon attempt fails, the system raises the value of the threshold that tracks the number
of unsuccessful logon attempts. The "reset user lockout threshold after" setting determines how long the lockout threshold is kept. This
threshold may be reset upon a successful login or if the preset waiting time for "reset user lockout threshold after" has elapsed since the
last unsuccessful logon attempt.

By default, the lockout threshold is maintained for one minute, but any value can be set between 1 and 99,999 minutes. Similar to the user
lockout threshold, select a value that balances security needs against user access needs. A good value is between one and two hours. This
waiting period should be long enough to force hackers to wait longer than they want to before trying to access the system again.

For more information on setting these parameters, see Configuration settings for Verba Web Application.

Locked users can be unlocked on the user configuration page. For more information see User Administration.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6817844/Web+application+settings
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816663/Users

Web interface layout

The Verba Web Application uses a common screen layout throughout the application.
After logging into the system, the Verba web-based graphical user interface (GUI) will load.

The GUI consists of three key components:

® Header and menu

® Body
® Web-based media player and viewer
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From top to the bottom the users see header with the menu, the main body of the page, and the embedded media player.

Although the web browser navigation features (Back, Forward, Stop, Refresh, etc.) may be used, Verba does not recommend the use of
these navigation buttons. The browsers may misinterpret the Back and Forward buttons because of the active content of the pages.

The page is separated into two frames:

® Header and body (scrollable)
® Player (fixed at the bottom of the browser window)

® Inorder to maximize the visible useful area of your browser, you can toggle "full-screen mode" (e.g. by pressing the F11 key on
your keyboard), and adjust zoom level if needed. You can also hide the Verba page header.

To configure the web access to the Verba user interface, put the index page into the "Favorites" list of the browser after the first
run. This way you do not have to type the server address at every start.






Body

The body contains the main part of the user interface. Every event (e.g. selecting a menu item), generated by the user, takes effect in this
interface area.

Pages, located in the body area, are described in the following sections.
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Header and menu

The header section is on the top of the browser page. From left to right the Verba page header section contains the Verba logo, the Verba
menu system and the Account Management menu.

The Verba page header cannot be hidden.

V Conversations  Quality Management ~ Workflows ~ Communication Policies ~ Reports ~ Users Data  System Verba Administrator &gy

The available menu items and functions depend on the authorization profile of the user.
The menu in the header makes navigation easier and quicker in the Verba Web Application.

The menu can be activated and navigated by using your mouse (pointing device) like in any other standard graphical user interface. If you
move the pointer over a menu, the items belonging to that menu will appear. By clicking the left mouse button the page of the desired
menu item opens.

‘Conversations Quality Management ~ Workflows  Communication Policies  Reports Users Data

| Q Search 9
A Your email alert settings are missing or incomplete. Learn how

EEE Views - <

Ongoing Evaluations

Agent Vi
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«§ Sharing Date Time Dur
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Certain menu items are only accessible with higher authorization levels. Menu items not available on an authorization level are hidden in
the list.



Menu structure

@ Menuitems and functions depend on the authorization profile of the user. Functions that are not available for the specific user
are hidden.

Conversations

This part of the main menu lets users access call lists with predefined selection criteria and sorting based on various filters. Normally the

search starts immediately after selecting a menu item. The resulting call lists appear in the Body area or in a pop-up window.

Group and system supervisors will have visibility to their respective authority circle of users when executing many of these queries.

Search - This menu takes users to the search criteria definition page where they can define various flexible search criteria to find

call recordings.

Ongoing - This item displays the list of ongoing conversations that are being recorded.

Agent View - Supervisors can monitor the work of agents by looking at their live desktop screen.

On-Demand Buffer - This list menu item displays conversations that are not yet kept but are marked for recording.
Saved Queries - This menu item contains the saved queries of the user that were previously defined in the search page.
Manage Shared Items - Conversations can be shared among users. This page lets users change the parameters of their
conversation shares. (i.e. extending/revoking access to a share).

View Shared Items - Conversations can be shared among users. This page displays the conversations shared with the user.
Participant Sets - Customised participant sets can be used to define a group of people within the system.

Speech Search Phrases - Users can search and list speech phrases by using the appropriate filters in this item.

My Exports - This item displays the export operations that the user created.

Quality Management

All Evaluations - Supervisors can rate the agent conversations by using this interface.

My Evaluations - Users can see their ratings using this page.

Projects - By creating projects supervisors can assign calls of certain agents to certain supervisors for evaluation.
Forms - By creating scorecards, the supervisors can rate the calls of their agents.

Skills - Agent skills like empathy, communication, technical knowledge, etc.can be added here.

Workflows

Request Access - This item offers users the option to select the requested data filtered to Users/Groups, Cases or Label in the drop-

down menu.
Requests - This item lists all the requests. Users can search for and list authorization requests.
Workflows - Users can create custom workflows to gain access to the requested conversations.

Message Templates - The email messages that are sent to requesters/approvers can be configured in the Message Templates item.

Users can select these templates in a workflow.

Communication Policies

Communication Policies - Communication Policies are the foundation of your Ethical wall, they define how and when Users and

Groups can communicate with each other.
Content Policies - Instant Messaging content can be filtered based on business requirements.



® Notifications - Users can define the messages to be sent to notifications, which then can be sent to selected parties when a given
communication channel is opened.
® Disclaimers - Users can define the texts of the disclaimers, which then can be sent to selected parties when a given communication
channel is opened.
Validator - Using the Communication Policy Validator users can test Communication Policies.
Audit Log - This item logs Ethical Wall events.
Reports
® Dashboard - This is a configurable tool providing a quick look at the most useful statistics for the user.
® Create New Report - By creating reports users can gain a summarized view of the data in the system.
® Report Templates - In this item users can create Report Templates and reuse them at a later time.
® Reports - This item displays an overview of previously created reports that can be downloaded from this page.
Users
Users - Administrators can access the user administration page from this item.
Groups - Administrators can access the group administration page from this item.
Extensions - Administrators can use this page to configure extension (phone) numbers to be recorded and link users to specific
phone numbers.
® Roles - This is the basis of the Role-based access control (RBAC) in the system. User rights can be defined in Roles and then the
roles are assigned to users.
® Active Directory Synchronization - The Active Directory Connection parameters can be defined here so that the users and
extensions in Verba are automatically synchronized from AD.
® Bulk User and Extension Update - In this field, the user and extension parameters can be bulk updated by defining the new values
of the parameters.
® Bulk User Import - This submenu allows administrators to create Verba user accounts using a bulk import feature.
Data
® Data Management Policies - Administrators can set up different types of data retention rules to define storage policies for the
recorded conversations.
® Storage Targets - Users can set up target folders for the data retention policies in this item.
® Import sources - Users can search and list the various import sources by using the appropriate filters in this item.
® Data processors - Users can search and list data processors by using the appropriate filters in this item.
® Manage Labels - This item lists the Cases that were placed on Legal Hold.
® Labelsin Legal Hold - This item lists the Labels that were placed on Legal Hold.
® Automatic Labeling - Users can find and list Label Rules in this item based on the set filters.
® Manage Cases - This item lists the cases that were previously created in the system. Users can add new cases to this page. For
more information refer to the Cases article.
® Casesin Legal Hold - This item lists cases placed on Legal Hold.
Export - Users can export groups of conversations and create backups of conversations in this item.
System
Servers - Administrators can register and administer all types of settings for the deployed Verba servers (e.g. local recorders).
Configuration Profiles - These profiles can be applied to Verba servers, making the administration of the servers easy and
convenient.
® Metadata Templates - Conversation records can be extended with Fields that contain additional information on that record can
be added to conversation records.
[ ]

Conversation List Layout - Administrators can define the content of the default List Layout, which is automatically assigned
to a new user.

Request Server Certificates - Service connections are encrypted by using certificates. Administrators can request certificates to a
new Verba server if it cannot access the web application during installation.


https://verbalabs.atlassian.net/wiki/display/docs/Cases

Encryption/Signing certificates - Recordings are encrypted by using certificates. Administrators can add and access the
certificates to be used.

API Keys - Software developers can create custom applications that access Verba through an API. The keys for the
communication with the APl can be managed here.

Audit Log - Administrators have access to the read-only event logs that provide an audit trail of certain user activities and system
events.

Alert management - Users can set up alerts in this item.

Background Tasks - This page shows the background tasks that are scheduled in the system (i.e. Data Retention Policies)
Collect Configuration and Logs - Users can collect and configuration setups and logs in this item.

Session Monitor - Administrators can view real-time status of active user sessions in the Verba Web Application.

Database Summary - Administrators can display summary information on Verba database including call information and
configuration databases here.

Database Purging - Administrators can remove erroneous call records from the database in this item.

License - Administrators can view the details of the currently applied license for the system, including the expiration date and the
number of licenses for each function.

Account information

My account - This item displays an overview of the user information.

Change password - Users can change their password at any time in this item.

Sign out - Logged in users sign out from the user interface here.

Online Help - This item opens a new tab in your browser, that points to https://kb.verba.com/

Online Support - This item opens the online Verba support page. Normally system support and administrator personnel use this
site (a user ID and a password are required).

Downloads - Administrators have access to various Verba plug-ins in this item.

® About - This item displays the version and registration information along with the EULA (End-User License Agreement).


https://kb.verba.com/

Updated menu structure in Verba 9

We have restructured the menu structure in Verba 9.
The reasons for this change were:

® too many main items - our menu structure grew a lot throughout the years, we had too many main menu items
® new functionality - new functionality in our pipeline did not properly fit into the existing structure
® unclear logic - the old structure included elements that did not properly fit in the menu where they were

The table below helps smooth navigation in the new structure:

Previous Menu Structure Location in New Menu Structure in v9.0
System
Logout User Account -> Logout
Change Password User Account -> Change Password
License System -> License
Certificates System ->[Security] / Encryption/Signing Certificates

Database Monitoring

Database Summary System -> [Monitoring] / Database Summary

Database Purging System ->[Monitoring] / Database Purging

Server

Session Monitor System -> [Monitoring] / Session Monitor

Background Tasks System -> [Monitoring] / Background Tasks

Media Troubleshooting System -> [Monitoring] / Media Troubleshooting
Collect Configuration and Logs System -> [Monitoring] / Collect Configuration and Logs
Request Server Certificate System -> [Security] / Request Server Certificate

Alert Management System -> [Monitoring] / Alert Management

Audit Log System -> [Security] / Audit Log

Conversations

Ongoing Conversations Conversations -> [Views] / Ongoing

Cisco Phone Monitoring Conversations -> [Views] Cisco Phone Monitoring

Agent View Conversations -> [Views] / Agent View

My Conversations Removed, go to search and filter for you user account or your assigned extensions/addresses

Important Conversations Removed, go to search and filter for Important under Metadata and Markers



Private Conversations
Conversation Buffer
Manage Shared Items
View Shared Items
Saved Queries

Saved query 1
Participant Sets

My Exports

Automatic Labeling

Search

Compliance

Cases

Casesin Legal Hold

Cases Waiting for Approval
Labels

Labels in Legal Hold
Labels Waitinf for Approval
Request Access to Users/Groups
Request Access to Case
Request Access to Label
My Requests

All Requests

Requests to Approve
Workflows

Workflow Message Templates

Policies
Communication Policies
Content Policies
Notification Templates

Disclaimer Templates

Removed, go to search and filter for Private under Metadata and Markers
Conversations -> [Views] / On-demand

Conversations -> [Sharing] / Manage Shared Items

Conversations -> [Sharing] / View Shared Items

Conversations -> [Views] / Saved Queries

Conversations -> [Views] / Saved Queries -> Saved query 1

Conversations -> Participant Sets

Data -> Export

Data -> [Labels] / Automatic Labeling

Conversations

Data -> [Cases] / Manage Cases

Data -> [Cases] / Cases in Legal Hold

Data -> [Cases] / Manage Cases

Data -> [Labels] / Manage Labels

Data -> [Labels] / Labels in Legal Hold

Data -> [Labels] / Manage Labels

Workflows -> [Authorization Requests] / Request Access
Workflows -> [Authorization Requests] / Request Access
Workflows -> [Authorization Requests] / Request Access
Workflows -> [Authorization Requests] / Requests
Workflows -> [Authorization Requests] / Requests
Workflows -> [Authorization Requests] / Requests
Workflows -> [Authorization Workflows] / Workflows

Workflows -> [Authorization Workflows] / Message Templates

Communication Policies -> [Policies] / Communication Policies
Communication Policies -> [Policies] / Content Policies
Communication Policies -> [Tenplates] / Notifications

Communication Policies -> [Tenplates] / Disclaimers



Validator

Audit Log

Data Management Policies
Storage Targets

Import Sources

Data Processors
Conversation Import
Conversation Export

List Phrases

Manage Phrases

Speech Indexing (Data Retention)

Automatic Labeling

Administration

Users

Groups

Extensions

Roles

Active Directory Synchronization
Bulk User and Extension Update
Bulk User Import

Metadata Templates

APl Keys

Default Conversation List Layout
Verba Servers

Configuration Profiles

Quality Management
Show Evaluations
My Evaluations
Projects

Forms

Skills

Communication Policies -> Validator

Communication Policies -> Audit Log

Data -> [Data Management] / Data Management Policies
Data -> [Data Management] / Storage Targets

Data -> [Data Management] / Import Sources

Data -> [Data Management] / Data Processors

Data -> [Data Management] / Data Management Policies
Data -> Export

Conversations -> Speech Search Phrases

Conversations -> Speech Search Phrases

Data -> [Data Management] / Data Management Policies

Data -> [Labels] / Automatic Labeling

Users -> [Administration] / Users

Users -> [Administration] / Groups

Users -> [Administration] / Extensions

Users -> [Administration] / Roles

Users -> [Management Tools] / Active Directory Synchronization
Users -> [Management Tools] / Bulk User and Extension Update
Users -> [Management Tools] / Bulk User Import

System -> [Configuration] / Metadata Templates

System -> [Security] / API Keys

System -> [Configuration] / Default Conversation List Layout
System -> [Configuration] / Servers

System -> [Configuration] / Configuration Profiles

Quality Management -> [Evaluations] / All Evaluations
Quality Management -> [Evaluations] / My Evaluations
Quality Management -> [Configuration] / Projects
Quality Management -> [Configuration] / Forms

Quality Management -> [Configuration] / Skills



Dashboard Reports -> Dashboard

Reporting

Create New Report Reports -> [Reports] / Create New Report
Report Templates Reports -> [Reports] / Report Templates
Reports Reports -> [Reports] / Reports

Help

Downloads User Account -> Downloads

On-line Help User Account -> On-line Help

On-line Support User Account -> On-line Support

About User Account -> About



Searching conversations

Resetting the search fields
® Saving and reusing search criteria
Basic search options
Query interval
Phon® number or address
User
Label
¢ Case
® Advanced Search Options
® Time zones in search results

® Scope

® Recording Audit
® Conversation detail record fields

® Metadata and Markers
® TextSearch
The conversation search page can be accessed through the Conversations \ Search menu.

Search D& [
¥ Basic Search Options ?
Interval
Fix Interval v
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Phone Number (From or To Party)

\l

‘.
User
- =
|:| Search conference paricipants
Label
P Advanced Search Options
b Metadata and Markers
b Text Search ?

P Speech Search

Reset Search
Cannot find a conversation?

This page allows the user to enter the search criteria to find recorded conversations. The search criteria attributes are divided into groups,
and placed on three separate vertical tabs to make search criteria definition easier:



®  Basic Search Options tab includes the most commonly used search fields.

®  Advanced Search Options tab includes the remaining technical attributes that allow more sophisticated search criteria to be
defined and used.

®  Metadata and Markers tab allows the user to narrow the search using the business data associated with the conversation records
(stored in custom metadata fields and markers).
® Text Search allows the user to search in the text recorded from instant message conversations. Any combination of the following
fields can be used:
® All of the listed phrases
® Any of the listed phrases
® None of the listed phrases

The user can navigate between these tabs until all of the search criteria have been specified, and then initiate the search by pressing the
Search button below the tabs. The search is executed based on the combined set of search field values on all tabs.

Resetting the search fields

After setting the search criteria, the system stores the field values, so whenever the user loads the search page the previous settings are
restored and displayed. To reset the fields, click on the Reset Search link in the bottom right corner of the search panel, or click on the

g

button on the top.

Saving and reusing search criteria

Itis possible to save several different search criteria, then reuse them whenever it's required. For more information, see: Reusing search
criteria - saved queries

Basic search options

Query interval

The time interval of the search results can be set under the Interval section. This criteria works based on the Start Time property of the
recordings.

Using the dropdown, a predefined time interval can be used.



Interval

Fix Interval ~

Fix Interval

Last 5 Minutes
Last 15 Minutes
Last 30 Minutes
Last 1 Hour
Today
‘Yesterday

This Week

Last Week

This Month
Last Month

If the dropdown is set to Fix Interval, then the interval can be set manually. In this case, the left date represents the oldest time of the
recordings and the right one is the oldest.

In order to modify the interval, click on any of the dates. The calendar pops up where the date and time can be set.

? May, 2006 X
i { Today 3 »
Mon Tue Wed Thu Fr Sat  Su

18 1 2 3 4 & ] 7
19 8 g n 11 12 13 14
20 15 16 17 18 19 20 21
21 22 23 24 25 26 27 28
22 29 3 A

Time: 00 : 00

Select date

For changing the month, click on either the left (<) or right (>) arrows on the top. For changing the year, click on either the double left (<<)
of double right (>>) arrows. The day can be selected by clicking on the date in the calendar.

The time can be set on the bottom. To increase the value of either the hour or the minute counter, left-click on the numbers. To decrease
the values, use SHIFT + left click. The values can be set also by holding the left button of the mouse, then dragging to left or right.

Phone number or address
The Phone Number field can be used for searching based on the From or To fields of the recordings.

Phone Number (From or To Party)
- walterw@chemistry.com * =

12778 3

12832 &3



Multiple phone numbers or SIP addresses can be provided. In this case, there will be an OR logic between the provided values. While
typing, the system also provides suggestions based on the configured extensions in the system. The '%' character can be used as wildcard.

A predefined list of numbers - or Participant Sets in other words - also can be provided by clicking on the

—

button. For more information about the Participant Sets, see: Participant sets

User
The User field can be used for searching based on the From (Verba) or To (Verba) fields of the recordings.
User
Sue Mathis (sue) x | =

Wesley Mack (wesley) x

Before using this field, the users have to be configured in Verba, and a proper user - extension assignment has to be present. Multiple Verba
users can be provided. In this case, there will be an OR logic between the provided values. While typing, the system also provides
suggestions based on the configured users in the system.

A predefined list of users - or Participant Sets in other words - also can be provided by clicking on the

—

button. For more information about the Participant Sets, see: Participant sets

(@ When using the Search conference participants checkbox, the values provided for the Phone Number and the User fields will
be used for searching in the conference participants also.

Label

The Label field can be used for searching based on the labels attached to the recordings.

Label

HR issue x

Reviewed x

Multiple labels can be provided. In this case, there will be an AND logic between the provided values, so the result will contain
conversations that are labeled with all of the specified labels. While typing, the system also provides suggestions based on the configured
labels in the system. For more information, see: Labels

Case

Instead of selecting the labels one by one, cases can be used for searching based on labels assigned to the same case. To use this search
field, the cases have to be created and the labels have to be associated with the cases. For more information, see: Cases


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816568/Labels
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816042/Cases

Advanced Search Options

Time zones in search results

In Advanced Search Options, users can temporarily change the timezone of the current search. All time information will be presented in the

selected time zone in the search results, when you Reset the Search fields.

Scope

By default, the system shows only the online conversations, so the searching will be fast also in case of a large number of old archived
recordings. If this setting is set to Archived Conversations too, then the search will apply to the archived recording also.

Recording Audit

This section is visible only if the Web Application \ Miscellaneous \ Hide not recorded conversations setting is set to No in the
configuration of the Verba server which hosts the web application.

Recording audit

L
L

Recorded conversations
Recorded conversations with incorrect media

Mot recorded conversafions due to error

Mot answered conversations

Filter

Recorded
conversations

Recorded
conversations with
incorrect media

Not recorded
conversations due
to error

Not answered
conversations

Description

Shows records without any error

Shows records, which has an indication for a media error

Note: these records are not available for all integrations

Shows the not recorded conversations inserted by the recording
services or imported by CDR reconciliation process. For information,
see CDR reconciliation.

Note: these records are not available for all integrations

Shows the not answered conversations inserted by the recording
services or imported by the CDR reconciliation process. For
information, see CDR reconciliation

Note: these records are not available for all integrations

Condition

Shows records where
® media file exists (except instant
messages and SMS records),
recording failed flag is not set,
end cause is not Caller Gave Up,
Busy, Unobtainable, Error,
® and there is no media error

Shows records where
® media file exists (except instant
messages and SMS records),
recording failed flag is not set,
end cause is not Caller Gave Up,
Busy, Unobtainable, Error,
® and there is a media error

Shows records where
® media file does not exist and the
end cause is not Caller Gave Up,
Busy, Unobtainable,
or recording failed flag is set,
or end cause is Error

Shows records where
® the end cause is Caller Gave Up,
Busy, Unobtainable


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816143/CDR+reconciliation
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816143/CDR+reconciliation

Conversation detail record fields
All search fields support adding multiple query/filtering parameters.

Conversation detail record fields

Wl | | Group v
Equal to v
US Billing v

+

Follow the steps below to add one or more filters to the desired search field:

Step 1-Clickon
+

the icon and select the desired field from the drop-down menu.
Step 2 - Choose the operation from the drop-down menu
Step 3 - Set the criteria in the last text box.

In case of multiple filters, there will be AND logic between the filters.

For more information about the available fields, see: Search fields

For more information about the available operators, see: Search filter operators

Users can remove previously added criteria by clicking on the

e

icon on the left side of the panel.

Metadata and Markers

This section provides the ability for searching in the metadata fields and in the markers. Under the Metadata fields setting, specific
metadata criteria can be provided:

Step 1-Clickon
+

the icon and select the desired field from the drop-down menu.
Step 2 - Choose the operation from the drop-down menu
Step 3 - Set the criteria in the last text box.

In case of multiple filters, there will be AND logic between the filters.

Users can remove previously added criteria by clicking on the

-

icon on the left side of the panel.

Text Search



The Text Search section can be used for finding a recording based on its content. It can be used for:

® |nstant Message recordings
® Voice recordings with transcript
® SMSrecordings

When using the All of these phrases textbox, there will be AND logic between the provided phrases. If the Any of these phrases textbox is

being used, then there will be OR logic. With the None of these phrases textbox, all recordings can be found which doesn't contain the
provided phrases.

By clicking on the Create labeling rule from these link, a new automatic labeling rule can be created from the provided criteria. For more
information, see: Labels


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816568/Labels

Reusing search criteria - saved queries

Every user can save a search query after it was executed, and rerun it at a later time. This feature is only available for conversation lists
which were generated through the search page because saving of for example built-in conversation lists is fairly unnecessary.

Save a Query
To save a search query, follow these steps:
Step 1 Enter the search criteria on the search page and execute the search by pressing the Search button

Step 2 When the result is displayed, users can define a label for the query in the top-right corner of the Search panel. Specify the label
and press the Save button. The name of the search query must be unique.

Step 3 Users will be notified of the success of the task and the query will be added under the Conversations / Saved Queries menu
item.

Load a Query
A previously saved search query can be loaded by simply selecting it from the menu. The saved queries are located under the

Conversations / Saved Queries menu item. Only those queries are listed that were saved by the user. The list of queries is generated when
the user logs into the Web Application.

Delete a Query

Unnecessary queries can be deleted by following the steps below:
Step 1 Load the query to be deleted by clicking on the Load query button on the Search panel, and select it from the menu.

Step 2 In the top-right corner of the Search panel, press the Delete button to delete the query.

Make a query available to other users

Administrators can associate a saved query to a group through the Group Queries Configuration menu. For further information, see
GroupsGroup guery configuration.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816678/Groups
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816678/Groups

Search fields

Basic Search Options

Field Name Description

Query Interval Start/End Time This tool is designed to define a date-time interval in a few easy steps. Once the start date-time of
a conversation falls into the given interval, it will be displayed:

? May, 2007 x
&« { Today ] »
2 3 4 5 6

7 8 9 0 11 2 3

21 22 23 24 25 26 27

28 29 30 31
Time 00 : 00
Select date

The selected date is displayed in red and can be adjusted using the following controls:
Date selection:
® Usethe << and >> buttons to select the year
® Usethe < and > buttons to select the month
Hold the left mouse button on any of the buttons for faster selection
Time selection:
® Click on any of the time digits to increase the value
® Shift-click to decrease the value
® Click and drag for faster selection

Since all date and time values are stored in UTC/GMT (Universal Coordinated Time), the displayed
date and time values depend on the time-zone setting of the user. You can override this setting by
selecting another time-zone on the Advanced Search Options tab

Phone Number (From or To Party)  The phone number of the caller or the called party can be entered here.

This field uses an auto-complete feature to list the matching registered numbers in a drop-down
menu as you type. Any other number can be entered, however, the auto-completion only works
for registered numbers.

User This field also uses the auto-complete feature to list the matching registered Verba users in a drop-
down menu as you type. Any other username can be entered here, however, the auto-completion
only works for registered Verba users.

Label Conversations can be marked by using labels. In this field, users can select from existing search
labels in a drop-down menu.



Advanced Search Options

Field Name
Display results
according to

timezone

Archived
conversations

From

From Info
From (digits)
From Device ID
From IP

From Proxy IP

To

To Info

To (digits)
To Device ID
TolIP

To Proxy IP
Both To or
From

Both To of
From Info

Dialed Number
User

Group

User ID
Direction
Direction (User)

End Cause

Description

Search results will be displayed according to this time zone

Determines whether the system will include archived conversation in the search or not

The initiating party's identifier (phone number, extension, SIP URI, etc.)

Searches in the From Info field of the records, that shows additional information on the conversation
Using this option, search results can be filtered based on how many digits the From extension contains
The initiating party's Device ID

The initiating party's IP address

The IP address of the media relay point from the initiating party's perspective. This can be the proxy server, edge
server, or other relay points.

The receiving party's identifier (phone number, extension, SIP URI, etc.)

Searches in the To Info field of the records, that shows additional information on the conversation
Using this option, search results can be filtered based on how many digits the To extension contains
The receiving party's Device ID

The receiving party's IP address

The IP address of the media relay point from the receiving party's perspective. This can be the proxy server, edge
server, or other relay points.

The initiating or the receiving party's identifier (phone number, extension, SIP URI, etc.)

Searches in the From and To Info fields of the records, that show additional information on the conversation

If the dialed number differs from the person that answered the conversation, this field is populated
Users who are in the Verba database

Users can select one or more Verba groups from the predefined list. Conversations linked to the users of the selected
group(s) will appear in the search results.

The User/Agent/Trader ID obtained from the recorded platform
You can select one or more of the directions from the predefined list (internal, outgoing, and incoming).
The direction of the conversation from the recorded user point of view (inbound, outbound)

What was the reason behind the termination of the conversation. Caller hung up, timeout, etc.



Duration
Interval

Conversation
Type

Forward
Reason

On-demand

Marked for
recording

Protected

Related
conversation
exists

Storage target

End of
Retention

Delete after
End of
Retention

Encryption
Certificate

Signature
Certificate

Silence Ratio
Talkover Ratio

Longest Silence

Users can define an interval. Every conversation will be displayed in the search result for which the duration is inside
the given interval. Specifying only the beginning or only the end of the interval results in conversations longer or
shorter than the defined value.

Seconds values greater than 59 are not accepted, however, minute values greater than 59 are accepted and converted
to valid 'hours:minutes' values automatically.

What conversation modalities should be displayed. Available options:

Voice

Video

Instant Messaging

Desktop Screen

Screen & Application Share (Lync/SfB)
Whiteboard (Lync/SfB)

Poll / Q&A (Lync/SfB)

File Share (Lync/SfB)

SMS

Conversation forwarding reason

Options are:

® Show only on-demand conversations
® Show only always-on conversations

Shows On-Demand conversations that have been marked to be kept
Conversation is Protected. If the system is set up to take this setting into account, then these conversations will not be
deleted even after the retention time has passed

Only shows conversations where related conversations exist (the whole conversation is stored in more than one file)

Which Storage target the conversation is stored on. This only has value if not the default storage location is being used

Shows when the retention time of a conversation ends

Available options are Yes/No, it can separate conversations that will be automatically deleted after the retention time
isup

Which certificate was used to encrypt conversations

Which certificate was used to sign conversations

Shows the ratio of silence in relation to the whole conversation
Indicates the amount of time when multiple parties were talking at the same time in a conversation

Longest time in a conversation when both parties were silent



Media Check Shows what problems were discovered for each conversation. Available selection options:

® No Media
® Length Mismatch
® RTP Loss
® RTP Duplication
® SRTP Decryption Error
® Decoding Error
® Media Mixing Error
® One-way Media
® Missing File
® Corrupted File
Voice Quality Makes it possible to search based on the rating of the conversation, done by the Voice Quality Check feature
Recording Hostname of the Recording Server that recorded the conversation
Server
Media File Searches based on the name of the media file
Name
Shared File Works with Content Sharing can filter based on the name of the shared file
Name
Shared File Works with Content Sharing can filter based on the file extension of the shared file
Extension
Conversation Verba's unique, automatically generated conversation identifier. The search result will include only conversation(s)
Identifier with the given identifier(s).
Platform The ID of the conversation that the Telephony/UC platform assigns to the session
Conversation
ID
Source What Telephony/Unified Communications system was the conversation recorded in (Cisco, Sfb, Avaya, etc.)
Platform

Import Source  The import source which imported the conversation

To see what type of filtering criteria can be used with most of these options, refer to the Search filter operators article.

(@ Youcan define as many search criteria as you wish. The search field values are linked with a logical AND. Therefore only those
conversations will be listed that meet all of the search criteria.

If all of the search fields are empty, every recorded conversation will be listed in the defined time range.

Metadata and Markers

As previously described, Verba allows the use of group-specific metadata templates. Depending on the user configuration, each user is a
member of one or more groups. When a user is logged into the Verba Web Application, the user can use any of those comment templates
for searching or adding new comments, which are defined for those groups the user belongs to.

Field Name Description

Full-text searchin Searches in the text description of the conversation markers. Works with a portion of the phrase as well, it does
markers not have to be an exact match



Metadata fields Contents of specific metadata fields can be searched for here

Text Search
This section makes it possible to search in text-based recordings, transcripts, and markers.

The search fields support '*' for a starts-with or ends-with match, or " " for an exact match.

Field Name Description
Instant Messaging Sets whether the Instant Messaging recordings will be in the scope of the searching or not.
Transcript Sets whether the transcripts will be in the scope of the searching or not.
SMS Sets whether the SMS recordings will be in the scope of the searching or not.
Markers Sets whether the markers will be in the scope of the searching or not.
All of these phrases Shows IM sessions that contain all of the listed phrases in one session

Any of these phrases Shows IM sessions that contain any of the listed phrases

None of these phrases  Shows IM sessions that contain none of the listed phrases

Speech Search

For the Speech Search Filters refer to the Speech Search Filters article.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6818607/Speech+Search+Filters

Search filter operators

When the user adds a Conversation detail record field to the search query under the Advanced Search Options, the system
automatically displays the different operation types for the selected fields. Search filter operators include the following, however, the
operator list differs by field:

Equal to The search query returns conversations where the selected field's value is equal to the specified criteria.
Special search characters cannot be used here.

Not equal to The search query returns conversations where the selected field's value is not equal to the specified criteria.
Special search characters cannot be used here.

Matches a value in the The search query returns conversations where the selected field's value matches a value in the list.

st When the user selects this operator, a multi-select drop-down menu or a text input box is displayed,

depending on the selected field.

Multiple items in the drop-down can be picked by holding down CTRL while clicking on each item to be
selected.

When the text input is filled, the system automatically displays another field for the next value.

Special search characters cannot be used here.
Does not matchavalue The search query returns conversations where the selected field's value does not match a value in the list.
in the list

When the user selects this operator, a multi-select drop-down menu or a text input box is displayed,

depending on the selected field.

Multiple items in the drop-down can be picked by holding down CTRL while clicking on each item to be
selected.

When the text input is filled, the system automatically displays another field for the next value.
Special search characters cannot be used here.

Does not exist The search query returns conversations where the selected field's value is not defined.
Special search characters cannot be used here.

Exists The search query returns conversations where the selected field's value is defined.
Special search characters cannot be used here.

Starts with The search query returns conversations where the selected field's value starts with the specified criteria.
Special search characters cannot be used here.

Ends with The search query returns conversations where the selected field's value ends with the specified criteria.
Special search characters cannot be used here.

Includes The search query returns conversations where the selected field's value includes the specified criteria.
Special search characters cannot be used here.

Like The search query returns conversations where the selected field's value matches the specified criteria.

Special search characters can be used here. These are described later in this topic.



Not like

Between

The search query returns conversations where the selected field's value does not match the specified
criteria.

Special search characters can be used here. These are described later in this topic.

This operator is only available for the Duration interval field. The search query returns conversations where
the field's value is in the specified timeframe.

Users can define custom timeframes, or use the drop-down menu for predefined settings.

Special search characters cannot be used here.

Special search characters

You can use certain special characters to perform "wildcard-search" using the following combinations:

The % character represents a string of characters at the position it is used. The system applies this character by default for phone number
fields. Search pattern variations denoted by * can be resource intensive and can result in long search execution.

filtertext%

%filtertext

%
filtertext%

If only the beginning of a field value is known, the remaining unknown string can be replaced with the "%" character. For
example specifying 414% in the extension search field will list all conversations where the extension number begins with
414.

* If only the ending of the value to be found is known, the remaining unknown string can be replaced with the "%"
character. For example specifying %414 will list all conversations where the field value ends with 414.

* If only the internal section of the field value is known, the preceding and trailing sections can be replaced with the "%"
character. For example typing %414% will list all conversations where the field value contains 414 after the first digit and
before the last digit.

If only the number of digits are known in the field, but one or more digits are uncertain, replace the unknown digit with "_"
(underscore) character. E.g. typing 4143_69 will list all conversations containing this pattern (the "_" can be any character,
excluding empty character).

If the number of digits in the field are known, but one or more digits are uncertain and the possible values are known, the
unknown digit(s) can be replaced with "[0123456789]" or "[0-9]" character(s). E.g. typing 4143[4-8]69 or 4143[45678]69
will list all conversations containing this number (the "[4-8]" or "[45678]" can be any number between 4 and 8).

None of the fields are case sensitive, so you can use either uppercase or lowercase letters. You can also combine the above mentioned
special search patterns.

Example search pattern

414[3-7]_6%

This will list all conversations that start with 414, the fourth number is one of 3, 4, 5, 6 or 7, the fifth number can
be any character (excluding nothing or an empty character), the sixth number is 6, and after character 6 the
number can contain anything (including nothing).



Special search modifier characters

You can use certain special characters to perform "wildcard-search" using the following combinations:

The % character represents a string of characters at the position it is used. The system applies this character by default for phone number
fields. Search pattern variations denoted by * can be resource intensive and can result in long search execution.

filtertext%

%filtertext

%
filtertext%

If only the beginning of a field value is known, the remaining unknown string can be replaced with the "%" character. For
example specifying 414% in the extension search field will list all conversations where the extension number begins with
414.

* If only the ending of the value to be found is known, the remaining unknown string can be replaced with the "%"
character. For example specifying %414 will list all conversations where the field value ends with 414.

* |f only the internal section of the field value is known, the preceding and trailing sections can be replaced with the "%"
character. For example typing %414% will list all conversations where the field value contains 414 after the first digit and
before the last digit.

If only the number of digits are known in the field, but one or more digits are uncertain, replace the unknown digit with "_"
(underscore) character. E.g. typing 4143_69 will list all conversations containing this pattern (the "_" can be any character,
excluding empty character).

If the number of digits in the field are known, but one or more digits are uncertain and the possible values are known, the
unknown digit(s) can be replaced with "[0123456789]" or "[0-9]" character(s). E.g. typing 4143[4-8]69 or 4143[45678]69
will list all conversations containing this number (the "[4-8]" or "[45678]" can be any number between 4 and 8).

None of the fields are case sensitive, so you can use either uppercase or lowercase letters. You can also combine the above mentioned
special search patterns.

Example search pattern

414[3-7]_6%

This will list all conversations that start with 414, the fourth number is one of 3, 4, 5, 6 or 7, the fifth number can
be any character (excluding nothing or an empty character), the sixth number is 6, and after character 6 the
number can contain anything (including nothing).



Searching in IM conversations and voice transcripts

¥ Text Search (”

Search in

# Instant Messaging
#| Transcript

# SMS

All of these phrases

weekly report

Any of these phrases
meeting

monday

None of these phrases

e-mail

Create labeling rule from these

Field Name

Searchin

All of these phrases

Any of these phrases

None of these phrases

Create labeling rule
from these

Description

What conversation modalities should be included in the
search. Available options:

® Instant Messaging
® Transcript
® SMS

The search will return conversations where all phrases are
matched

The search will return conversations where at least one
phrase is matched

The search will return conversations where none of the
phrases are matched

Create an Automatic labeling rule based on current search
criteria



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816595/Automatic+labeling

Conversation lists and actions

Users can search for recorded conversations, and the search results can be displayed through conversation lists.
Conversations lists can be accessed from various parts of the user interface including the following:

Clicking on the Conversation menu item

Selecting Conversations [ Search submenu and filling in the criteria
Selecting Conversations [ Ongoing Conversations submenu

Loading a previously saved query from Conversations / Saved Queries

The conversation list is displayed in a tabular format where the columns can be configured by the administrator or the user can personalize
it using the System [ Conversation List Layout menu.

Conversations s T =8 2

37054 tems found, displaying 110 20, Pages) H:: 55 s > Resulsperpage 20 v

2aBv 43:18 PM 00:00:00
=R 4 N ) 34318 PM 0.0
[=3=R: 4 N ) 34317 PM 00:02:05 16822 N
EEY XS 22,2018 55444 PM 000000 10401 N
BEBRU0% Jul 01 4:44 PM 00:00:0¢ 04010 N
EES XA 2,2 o000 04021 Norm
EELYE 22,201 o000 o
EET YRS 2, 20 w300 Normai
EES YRS 22,2016 aor0 Norma
EELYES w2, 20 ot0000 04020
[=R=R:4 ) Jul 22, 2016 035400

Every conversation list displays the calls ordered by date and time (in descending order). This means that the most recently recorded
conversation is the first, while the oldest conversation is the last one in the list.

Predefined queries (not initiated from the Search menu) cannot be filtered further. The result list will contain every recorded conversation
that meets the predefined criteria. E.g. selecting Conversations / Ongoing Conversations submenu will show every ongoing call of the
logged in user.

Use the Search page to narrow down the call list.

(@ [Ifasecurity profile has a "search window" limit set, then only conversations recorded in the last x hours can be listed. A message
informs the user about this at the top of every conversation list.

Small Letter Icon

When the conversation includes a desktop screen recording, then an Sicon is shown in the call list.

Using the Conversation List

® Conversation fields



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6815781/Screen+capture

Conversation list layout

Conversation list navigation bar

Delete conversations

Downloading a single media file

Get direct link

Mark conversations as Protected

Metadata columns on conversation lists
Ongoing conversations

Playback and download multiple records simultaneously
Playing back recorded conversations
Presentation of complex conversation scenarios
Private conversations

Right click options on conversation lists
Sending an email

Silent monitoring ongoing conversations
Timeline View




Conversation fields

A conversation list consists of a list header and one line for each record found matching the search criteria. The system administrator can
configure the default layout, and every user can personalize the list layout further: configure the fields (columns) to be displayed and their
order (see the next section for more information).

The following table shows the available fields. Not all fields are filled in for all integrations. Check the description of the integration to see
which fields are available.

Category

Participants

Details

Field

From
To

From (Verba)
To (Verba)
From Info
To Info

User

User ID

From Device
To Device ID
Dialed Number

Recorded
Extension

End Cause

Direction

Direction (User)
Start Date Time

Start Date Time
(GMT)

End Date Time

End Date Time
(GMT)

Duration
Start Time
End Time

Video
Thumbnail

Description
The number of the caller party in the conversation
The number of the called party in the conversation
The name of the Verba user associated with the calling party
The name of the Verba user associated with the called party
The name of the caller party in the conversation
The name of the called party in the conversation
The recorded user associated with the conversation
The User/Agent/Trader ID obtained from the recorded platform
The Device ID of the calling party
The Device ID of the called party
The original dialed number

The recorded extension number associated with the conversation

The end cause of the conversation (e.g. normal, hold, transfer, etc.)

The direction of the conversation from the communication system point of view (e.g. internal,
inbound, outbound, etc.)

The direction of the conversation from the recorded user point of view (inbound, outbound)
Start date and time of the conversation

Start date and time of the conversation in GMT/UTC timezone

End date and time of the conversation

End date and time of the conversation in GMT/UTC timezone

The length of the call in hhh:mm:ss format
Start time of the conversation
End time of the conversation

Thumbnail image from the beginning of the video recording



Analytics

Technical

Conversation
Type

Forward Reason
End of Retention
Delete after End
of Retention
Storage target

Encryption
Certificate

Signature
Certificate

Labels, Cases
Silence ratio
Talkover ratio
Longest Silence

Media Check

Voice Quality

Recording
Server

Audio Codec
Archive Status
File Format
Video Codec
Platform Call ID

From IP

The type of conversation. Available options:

Voice

Video

Instant Messaging

SMS

Desktop Screen

Screen & Application Share (Lync/SfB)
Whiteboard (Lync/SfB)

Poll / Q&A (Lync/SfB)

File Share (Lync/SfB)

The forward reason for the conversation (e.g. forwarded, transferred, team call, delegated, etc.)

End date and time of the retention period based on the retention setting applied to the
conversation

It shows if the conversation will be automatically deleted after the retention period expires

The current storage location of the media file(s) associated with the conversation

The certificate which was used to encrypt the conversation

The certificate which was used to sign the conversation

The labels and cases associated with the conversation

The ratio of silence in the conversation

The talkover ratio of the conversation

The length of the longest silence present in the conversation

It shows the media processing errors during recording. The system can identify the following media
errors:

No media

Length mismatch

RTP loss

RTP duplication

SRTP decryption error
Decoding error

Media mixing error

The overall voice quality check score for the conversation

The hostname of the Recording Server which recorder the conversation

The audio codec of the recorded stream

It shows if the conversation record is archived in the database or not

The file format of the media file

The video codec of the recorded stream

The unique identifier of the conversation received through the integration

The IP address associated with the calling party



Metadata
Fields

TolP
From Proxy IP
To Proxy IP

Source Platform

Import Source
Conversation ID
Recording Failed

Record Type

2N Source

Custom
Metadata Fields

The IP address associated with the called party
The IP address of the proxy server associated with the caller party
The IP address of the proxy server associated with the called party

It shows which telephony / unified communications system the conversation was recorded on
(Cisco,Sfb, Avaya, etc.)

The import source which imported the conversation
The unique identifier of the conversation which was generated during recording/capture/import
It indicates if the recording has failed and the metadata was imported during CDR reconciliation
It indicates the type of the database record:

® Standard

® CDR-Only

® Media-Only
In case of duplicate (2N) recording, records are marked as primary or secondary

Custom metadata fields configured in the system, the list of available fields might vary depending
on the integration configured and the metadata templates added



Conversation list layout

The default conversation list layout is configured by the system administrator. When a new user is created, the default conversation list
layout is automatically assigned to the user. Users can customize this (select the fields/columns to be included and their order) if the
system administrator provided the necessary rights (Conversation List Layout) to the user, from the System menu.

The right panel contains the configured/selected fields and their column position and order. The left panel contains the remaining fields
available for selection.

Conversation List Layout Configuration ?
Selectable Columns Added Columns
Labels, Cases
Participants 7y A Start Date
Dialed Number Start Time
From (Verba) Duration
From Device User
Recorded Extension Conversation Type
To (Verba) “ From
To Device m From Info
User ID To
Details 15) To Info
Analytics B) Direction
Technical 16)

e

Adding a field to the Conversation List Layout
To add a field to the conversation list layout, first select the desired field in the left pane (where the available, not selected fields are listed)

by checking the checkbox to the left of the field name. Then press the >> button, which will move the field over to the right to the end of the
Added Columns list where you can move it to its desired position (see the Changing field order section below).

Removing a field from the Conversation List Layout
In order to remove a field, select the desired field on the right pane (where the selected fields are listed) by checking the corresponding

checkbox, then press the << button.

Changing field order

In order to change the order of the selected fields, select the desired field by selecting the checkbox in the right pane (where the selected
fields are listed), then press the Up button to move a field up in the order or press the Down button to move a field down in the order.



Conversation list navigation bar

The navigation bar is displayed at the top and the bottom of the conversation list. This indicates the number of total records selected, and
the navigation position within the list if the list is longer than a page (usually 20 items fit one page).

For multi-page lists, the navigation bar indicates the range of records displayed, lists the page numbers with the current one highlighted,
and contains the navigation controls.

44 items found, displaying 1 to 20. Page(s): n 2 3 = =

The following navigation options are supported (wherever applicable) for multi-page lists:

To display and navigate to a given page just click on the page number.
Click the "|<" icon to go to the First page of the list.

Click the ">|" icon to go to the Last page of the list.

Click the "<" icon to go to the Previous page of the list.

Click the ">" icon to go to the Next page of the list.

(@ The system automatically navigates to the first page when the list is resorted by the user.






Delete conversations

Recorded conversations can be deleted directly from any conversation list.

ﬁ' The trash icon indicates that the conversation can be deleted. If the user's permission does not include the right to delete
conversations, no icon is displayed for the delete icon.

After pressing the delete icon, the system deletes the CDR information from the database and all corresponding files including the media
file. As an alternative to this function, administrators can set up a data retention policies, which can automatically delete conversations
based on various filtering options.

(@® Thisaction CANNOT be undone!






Downloading a single media file

If a user is granted the download right (given by an administrator), they are able to download the recorded media file to their local PCs. For
setting a download right see Verba Administration Guide, User Administration.

&  Click the download icon next to the media file you need to download. The download operation starts automatically.

Downloading time depends on the file size and the connection speed.

The filename of the media file is generated automatically in the following format:

Calling_party_number--Called_party_number_Start_date_and_start_time.ext

where .ext is the extension of the media file, depending on the file format.

Providing download reason

Users can be prompted for providing Playback Reason when clicking on the Play icon. In this case, the web-based media player will pop up
only when the reason is provided.

For this feature, the "Require Access (Playback/View/Download) Reason" setting has to be turned on at the user's role. For more
information, see User roles and User permissions.

Download Reason



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816663/Users
https://verbalabs.atlassian.net/wiki/display/docs/User+roles
https://verbalabs.atlassian.net/wiki/display/docs/User+permissions

Get direct link

Avalid HTTP/HTTPS URL pointing directly to a given conversation recorder from any conversation list may be sent to the users. The same
URL is generated, when the send email function is invoked on the conversation.

1# Thepiniconindicates that the URL pointing to the given conversation can be accessed. Simply press the pin icon to copy the
desired URL to the clipboard.



Mark conversations as Protected

Conversations intended to be kept in the system can be marked as Protected.

U Protectbutton.

After pressing the Protect button, the system marks the conversation as Protected. By pressing the button one more time, the marking is
removed.

The administrators can configure the system in a way that all conversations marked as Protected are not deleted even if all other
conversations are automatically deleted (e.g. after 30 days).



Metadata columns on conversation lists

The columns shown on the conversation lists can be customized. By using this feature, metadata columns defined by administrators in the

Metadata designer can be added to the data. These extra columns can store business information like Customer or Transaction IDs, or
SOurce Platforms and much more. Different business fields can be added for different groups of an organization.

P EOER U S® Jul22,2016 45444PM  00:00:00 ceo@hoolie.com g;\;e conference (le;_f:r;%i) SIEF[MC

» @D

@ Inthe example above the Source Platform field is added so that platform information can be stored for each conversation.

The information in these fields can be added in the following ways:

® manually through the ongoing conversations or regular search conversation lists
® usingintegrated Verba desktop phone applications (currently in the Cisco environment)
® automatically using the HTTP Business API


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816641/Metadata+template+fields
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6817154/Cisco+IP+phone+quick+reference
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816925/HTTP+Business+API

Ongoing conversations

In the system, ongoing conversation recordings can be listed by selecting the Conversations [ Ongoing submenu. The group level and
administrator privileges decide whether or not this function can be accessed and which ongoing recordings are displayed.

The followings apply to ongoing conversations:

The page displays conversations that have no end date set (yet).

Information obtained or calculated at the end of the conversation is not available: e.g. Duration, End Date, End Time, End Date-
Time.

The conversation cannot be played back unless it is trader voice recording where call splitting is active.

The conversation cannot be downloaded (nor individually or using the multi-record download).

Silent monitoring can be invoked on ongoing voice conversations.

Recording can be started or stopped for voice recording if controlled recording is configured, see Using the start/stop controls .
Recording can be paused or resumed, see Using the pause/resume controls.

Ongoing chat conversations are displayed for integrations using the standard data model, but integrations using the advanced
chat data model are not (e.g. Microsoft Teams). For more information, see Data models.

® Labels and legal holds can be added to conversations.
® Conversations can be added to cases.
® Custom metadata can be entered and attached to ongoing conversations.
® E-mails can be sent with a URL link pointing to an ongoing conversation.
Search ©  Ongoing Conversations D aworefiesnin 10 v secs | & b Ll 0 B
<
RESicSearaoptons ? 3 items found, displaying all items. Results perpage 20 v
From or To Party
=4 -
veer Start Date .Is.l":': Duration + User From rr:%m To To Info Direction zzfv‘:f'"g .?.::gr:?e
= Kenneth
O Search Al Partiipants > = & Dec10,2017 43806PM Z:’E”K”” 1096 I::mn 1079 fh‘;emsasm PSTNIn  QW-SERVER
Label Mathis
W 007x [HRissuex
Case O - = Jul22,2016  2:54:44 PM sid@darkside.com Sidius ani@darkside.com Anakin PSTNIn QM-SERVER
- All Conversations - v [ -
> Advanced search Options O = % B Jui22,2016 25444PM scott thomas@industry.com Scot thomas jefreys3@buyer.com Thomas PSTNIn QM-SERVER

Thomas Jeffreys

» Metadata and Markers

set Searct
foe e
Cannot find a conversation?

3 items found, displaying all items. Results perpage 20 v

©® Incertain error situations, conversations might remain on the ongoing list even after they are over. This behavior is always a fault
that the support team should investigate. The ongoing conversations started more than two days ago can be forcibly removed by
using the System [ Database [ Database Purging menu.

Refreshing the page

To refresh the ongoing conversation page only once, press the

u
L=

icon.

To refresh the ongoing conversation page periodically first, check the Auto refresh checkbox and select the appropriate timer interval
from the drop down menu in seconds. To turn off the automatic refresh, uncheck the Auto refresh checkbox.


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816014/Data+models

Using the start/stop controls

The start and stop controls allow users to control the recording. In order to use these controls, the controlled recording mode must be
configured for the recorded extension associated with the user (not all integrations support controlled recording).

When controlled recording is enabled for the extension, the system will automatically create a "control or placeholder" record in the
database which will be visible on the ongoing conversation page.

Every time the recording is started, a new record is created in the system. Subseqent start/stop controls will create multiple records in the
system, which will not be stitched together.

To start the recording, press the

®REC
button. The system immediately creates a new record in the database for the ongoing recording. The page will keep displaying the original
"control" record too (there will be 2 records, the original control record, and the new recorded call record).

To stop the recording, press the
@®sToP
button on the control record. You will notice that the recorded call entry will disappear since the recording has stopped for the call.

Using the pause/resume controls

The pause and resume controls allow temporarily stopping and restarting the recording, essentially muting and unmuting the recording
during a live call. Users must have Mute Recording permission, and the feature is only available for voice recordings. The pause action will
not stop recording entirely, and there will be no new record created when the resume action is triggered. The system still creates a single
recording where one or more segments are muted and substituted with silence.

To pause the recording, press the

button.

To resume the recording, press the

»
button.



Playback and download multiple records simultaneously

Users have the option to play back or download selected audio-only records simultaneously. The server will mix these records together
based on the StartTime timestamp.

For this option, the users need to do the following:

® (Click on the Select Multiple Conversations button (

) at the top right corner of the page
® Checkboxes appear in front of every record. Users can select which conversations they would like to mix together.
® Once the required conversations are selected, the Play and Download buttons can be used just above the list of conversations.

OB | E U Jul 22, 2016 12:00:44 PM 03:54:00 sid@darkside.com Sidius ani@darkside.com Anakin
N
Case External conversations
Th

M@ U® % Maydt 2015 11:57:48 AM 00:04:21 181863591 1222 PD?J”;;’S

YA WD U® % May3t, 2015 11:49:36 AM 00:02:28 1848 Shar_m 136334128
Harrington

YE Wl U % May31, 2015 8:53:56 AM 00:04:49 1939 Sue Mathis 110554729

M uwh U&® % May30 2015 5:47:19 PM 00:01:05 1914 Michael Cohen 159049228

M uwhU® % May30 2015 6:42:51 AM 00:03:04 1222 Thomas Powell 168770951

Upon selecting the playback option, the Verba player opens.

00:00 00:02 00:04 00:07 00:09 00:12 00:14 00:16 00:19 00:21 00:24

b ) D

@ Inthisview, only the basic player controls can be used, markers and other features are disabled, as all of those are used for
specific records.






Playing back recorded conversations

Arecorded conversation can be directly played back from the conversation list by clicking on the left most (play) icon in the conversation
list table. The icon has a different display depending on the following conditions:

> Play - By pressing the play icon left to the conversation list record, the selected conversation is loaded into the player and
playback starts immediately.

@ Locked - This icon indicates that one of the parties flagged the conversation as private. If the current user did not participate in
the conversation, they cannot play this conversation back.

No media file - If there is no media file for the selected conversation, the no media file icon appears.

Not uploaded - If the media file has not been uploaded yet to the Media Repository, the not uploaded icon is displayed. Thisicon
is only applicable for distributed, multi-site Verba deployment.

Archived - If the media file has been archived for the selected conversation, the archived icon appears. If the media file is in the
archive folder, it can be played back by pressing this icon.

If the user's permission does not include the right to play back recorded conversations, no icon is displayed in the place of the play icon.

After pressing the play icon, the selected media file loads into the media player located at the bottom of the page. The media player starts
playing the loaded conversation automatically.

(® Do not press the play button on the media player on workstations without a sound card! The computer may freeze and reboot
will be necessary. This is a Windows Media Player issue.

For more information on using the Verba player see the Verba Player section.

Providing playback reason

Users can be prompted for providing Playback Reason when clicking on the Play icon. In this case, the web-based media player will pop up
only when the reason is provided.

For this feature, the "Require Access (Playback/View/Download) Reason" setting has to be turned on at the user's role. For more
information, see User roles and User permissions.



https://verbalabs.atlassian.net/wiki/display/docs/User+roles
https://verbalabs.atlassian.net/wiki/display/docs/User+permissions

Playback Reason




Presentation of complex conversation scenarios

Complex conversation scenarios (like hunt groups, transfers, forwards and more) can be tracked using the additional information
presented in the Caller info and Called info fields of the Conversation List.

The screenshot below illustrates a conversation transfer:

1. william.lawrence@verba.com is calling info@verba.com (an example for an internal information line)
2. The conversation gets transferred to peter.harrison@verba.com (it takes 13 seconds in this case to discuss the transfer)
3. peter.harrison@verba.com answers the conversation (33-second long discussion)

Conversations in the screen below are presented in reverse order with the latest conversation on the top (this order can be changed by
clicking the column name on the top).

Having the different conversation legs in different conversation records provides security benefits. The supervisor of the info@verba.com
address will see the transfer discussion, but if the person has no access to peter.harrison@verba.com's conversations, then those will be
not visible for that account.

(@ Thisexample is based on SIP addresses (e.g. on a Microsoft Lync platform), but regular phone numbers are also presented the
same way. If the display name is available in the phone system, the caller/called info field also displays that name.

Calls E A
2 items found, displaying all items. Page(s): n Results per page | 20 |Z|
Start Start - Called Phone End
Terr Time Duration = Caller Phone Number Caller Info Harher Called Info ST
[ =] ﬁ' s¢ [F ., Jul 30, 2012 4:15:13 PM 00:00:13 william.lawrence@verba.com (william.lawrence@wverba.lab) peter.harrison@verba.com Peter Harrison Caller
-= (info@verba.lab) Terminated
» = ﬁ' s¢ [® ,Jul 30, 2012 4:18:43 PM 00:00:33 william.lawrence@verba.com William Lawrence info@verba.com Verba Technologies Transfer
(info@verba.com) -= Peter
Harrison
(peter.harrison@verba.com)
2 items found, displaying all items. Page(s): n Results per page | 20 |Z|

Export options: Excel | CSV | PDF | Download all



Private conversations

In the Verba System, users can flag a conversation as "private". After a conversation was flagged as private, other users (including
supervisors and administrators) are not allowed to play back the conversations (only users having participated in the conversation).

This feature is only available for users who participated in the conversation, whose user profile includes the right to flag a conversation
private.

Private conversations can be easily listed using the Conversations / Private conversations submenu. The private conversation list is
maintained separately for each user (every user has different private conversation list).

Private conversation flagging is built into the commenting feature. The "Private" flag is an embedded dcomment field of the default
comment template.

(@ Theonly way to play back a private conversation is by logging into the system with a username and password belonging to one
of the conversation participants. If the parties deny providing their password, system administrators can change the passwords.

To remove the "private" flag, just uncheck the corresponding checkbox on the conversation detail page and save the changes.

Conversations can be flagged as "private" from the telephone by using the Verba XML service. For further information see Flagging a
conversation as private.




Right click options on conversation lists

Every conversation list enables one to apply certain filtering options by right-clicking on a phone number.

Verba
P L - B B Mar24,2022  643:30PM  00:01:00 S R T

Administrator
Search List Options
Filter this list by: 24101
Verba

il P Y AT "
% = Mar2d4 2022 G.43:25 PM 00:01:00 Administrator 24 All conversations fromito, same day: 24101 [ Cut

All conversations fromito, same day +/~ 1 day: 24101

Verba
¥ = Mar24 2022 64328 PM 00:01:00 - 24101 AYoung 3123212312 DestName PSTN Cut
Administrator

These filtering options are useful when the user would like to find corresponding conversations to a given phone number. The following
table describes the available options:

Option Description
Filter this list by By applying this option, the current list will be filtered by the number, over which the right-click was initiated.
The new results will be deployed in the same window.
All conversations By applying this option, the current list will be filtered by the number, over which the right-click was initiated,
from/to, same day and that date will be used, which was selected by the right-click. The new results will be deployed in the same
window.
All conversations By applying this option, the current list will be filtered by the number, over which the right-click was initiated,

from/to, same day and that date +/- 1 day will be used, which was selected by the right-click. The new results will be deployed in the
+/-1day same window.

After applying any of these options, on the top of the new list, the filter setting can be canceled.



Sending an email

If a user has the right to send e-mails, a URL pointing to the selected conversation will be sent via e-mail to them or to the Administrator of
their (primary) group. For setting the e-mail sending right, see the User Administration topic in Verba Administration Guide.

B4  Tostart sending an e-mail, press the envelope icon in the conversation list. After pressing the icon, the default email client is
opened with pre-populated data.

- y
31 ¥ 9 + o+ |5 Recorded call direct access (Verba) - 2125551781->1625709580, May 30, 2010 8:03:16 AM - Message (HTM... E@g
File Message Insert Options Format Text Review Add-Ins & 0
3 0 Calibri =12 v A A SSH @ Q —{ @ ¥ Follow Up ~ |\%
i 5 = A ? High Importance
Paste B 7 U | %7 - Address Check | Attach Attach Signature Zoom
- - = Book MNames | File Item~ < § LowImpartance
Clipboard = Basic Text [F} Mames Include Tags G| Zoom
From ~ harrison @verba.com
To... |su rvisor @verba.com ‘
e || |
Subject: | Recorded call direct access (Verba) - 2125551781->1625709580, May 30, 2010 8:03:16 AM \
&
Dear Supervisorl =
The requested call is available by clicking on the link (Valid Verba login ID and password are required!):
http://verba-test/verba/callDetail.do?CCDR_|D=adfcbadl-4c48-11de-b88d-0019b9cfd7ad
Caller: 2125551781 (Leo Tolstoy)
Called: 1625709580 (Alec Baldwin)
Start: May 30, 2010 8:03:16 AM
Direction: Outgoing
Duration: 00:01:39
Sincerely,
Verba Administrator
-
a See more about: supervisor@verba.com. -



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816663/Users
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816358/Administration+Guide

Silent monitoring ongoing conversations

Ongoing conversations can be silently monitored from the Conversations [ Ongoing Conversations menu item.

p  Theplayand the bubble icons indicate that the conversation can be silent monitored. If the user's right does not include the right
to silent monitor conversations, no icon is displayed for the silent monitor icon.

< . .
Search 2 Ongoing Conversations c 2,8 T E 8 7
- i 2
Basic Search Options ! 2 items found, displaying all items. Results per page | 20[ %]

Phone Number (From or To Party)

=4 ) . F—

Start Date Start Time: Duration From From Info = To To Info Direction

User =) @ Jan 19,2018 1:16:10 PM kirk@verbatest local skywalker@verbatest local Internal

=3

OB U % Janig2018 1:15:39 PM Krk@verbatestiocal  James T.Kirk  skywalker@verbatestlocal Intemnal

[] Search conference pariicipants

e 2 items found, displaying all items. Results per page  20[v|
abel

» Advanced Search Options

¥ Metadata and Markers

Reset Search
Can not find a conversation?

Q Conversation View (=N

Conversation Details

n A1 00:00:49 (@ L) 5 Jan 19, 2018 1:16:10 PM -
o]
& Kik@verbatestlocal

Monitoring

‘skywalker@verbatest local
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~ Basic Search Options ?
2 items found, displaying all items. Resulis perpage = 20 ¥
Phone Number (From or To Party)
L =]
Start Date Start Time Duration From From Info To To Info Direction
u
i" 7_ =] ¥ Jan 19,2018 1:16:10 PM Kirk@verbatest local skywalker@verbatest local Internal
) =]
OB U % Jan19,2018 1:15:39 PM kirk@verbatest local James T. Kirk skywalker@verbatest local Internal
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e 2 items found, displaying all items Resulls per page | 20 v
%
» Advanced Search Options
» Metadata and Markers
Reset Search
Can not find a conversation?
Q Conversation View ? - O®
Instant Messaging Conversation Details

Export options: Excel| RTF| POF
B4 Jan 19, 2018 1:15:39 PM -

From  Message To  Timestamp
@
‘ hi 1:15:39 PM ‘ kirk@verbatest local (James T Kirk)
skywalker@verbatestlocal
nello 1:15:46 PM
Protected
- how are you? 11551 FM
Private
doing well, and you? 1:16:01 PM Important

Three types of silent monitoring features are available:

® Online (works with all our recorders) - use the built-in web-based media player located at the bottom of the page (see the codec
requirement below) - works with Cisco, Lync, Avaya and more
® Phone-based (Cisco) - use Cisco silent monitoring, where the silent monitoring session is sent to the Cisco phone - only on Cisco

UCM platforms

Whisper Coaching (Cisco) - use Cisco whisper coaching - only on Cisco UCM platforms above version 8.5

Dial-in (works with all our recorders) - a dedicated silent monitoring line can be called that streams ongoing conversations after
authentication

Q Conversation View k=N
The selected conversation can only be silently monitored using a Cisco IF phone.
Please provide a directory number, which will be used by the system to silenfly monitor the conversation, then press the Start Conversation Details
button
. £ Jan 19, 2018 3:19:36 PM -
1020 Silent monitor = 3
Whisper coaching

@
& 12106 (Luke Skywalker)

2026

@ Thesilent monitoring feature requires the Verba Unified Media Codec to be installed on the client computer. The codec can
be downloaded from the download page at support.verba.com (requires login). During the silent monitoring session, the
Windows Media Player is instructed to connect to the recording server directly on a configured port. The UDP port range 16384-
16500 must be open on the firewall of the client PC, where the codec is installed (not on the server). Ports need to be
opened on the Recording Servers, based on the platform being used (Please refer to Firewall configuration).

(® Do not press the play button on the media player on workstations without a sound card! The computer may freeze and
rebooting might be necessary. This is caused by a Windows Media Player bug, we have little control over this.

The Chrome browser does not support the Media Player plugin so it cannot be used for Silent Monitoring.


http://support.verba.com
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6815908/Firewall+configuration

For more information on using the Verba player see the Verba Player section.


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6817323/Media+player+quick+reference

Timeline View

The Timeline View shows the recorded conversations listed in the conversation list on a diagram, so it provides a visual representation of
the recordings in time. It provides a more informative view of when the conversations actually happened, and how long they were
compared to each other.

The Timeline View can be turned on by clicking on the
OF

icon in the upper right corner of the conversation list layout. Once it's turned on, it can be turned off with the
0%

icon.
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b Metadata and Markers PEIZEB0SE W s
P Text Search ? PADER 0% E @ Jus 208 61633 P 00.13.00
b Speech Search

FPADER 0% $ 42008 60533PM 001000 E1S33PM ritchie roberts@nypd gov

P A ER U % & Jus20E  55133FM 001300 BO433FM  franklucasg@nariem com

FPAOER U S E § L4201 SATINEM 004500 63233PM  fanklucas@hariem.com

[=X=0_§ A3 » Jul4 2018 54433PM 00:50:00 63431 PM Trank WS @Nanem com

When a conversation is selected on the Timeline View, the corresponding recording will be highlighted in the conversation list.

It's possible to scroll horizontally in the Timeline View by clicking and holding the left mouse button and dragging to left or right. If there
are more than four conversations in the same time period, then the scrolling vertically may be required using the same method in order to
show them. Zooming is also available by using the mouse wheel.



Conversation details

Detailed information is shown for each recorded conversation on the call details screen.
To access detailed conversation information data, select the conversation record by clicking on the appropriate row with the left mouse
button (the background color of the row changes when the cursor is moved over the record).

() Todisplay detailed conversation data, click on one of the columns/fields of the desired row. Do not click on the icons on the left,
because that will start the corresponding function without displaying the conversation detail page.

After selecting a conversation record, the Conversation Details page appears, containing all available information about the recorded

conversation.

Call Details

Call Details Data
Call Start
Duration
Caller Party Phone Number
System Caller Party Name
Verba Caller Party Name
call 1dentifier
Caller Party IP Address
Audio codec
Archived
End

Technical Call Identifier

May 30, 2010 12:47:30 PM call End

00:00:07 Call Direction
2125551780 Called Party Phone Number
1an Flemming System Called Party Name
1an Flemming Verba Called Party Name
cd0df4e3-9a0f-11dd-8a4a-0019b9cf47ad Recording Server
10.0.13.84 Called Party IP Address
G.711 u-law 64k Video Codec
false

Normal File format

£9.28.111.6-0-1302411486-0-1262839281 Data Retention Events

Add new comments based on the selected Template

Default

[+] Select a comment template first and then push the 'Show button,

The following functions are available on the conversation detail page:

May 30, 2010 12:47:38 PM
Outgoing
8486157450

Alan Alda

NEWYORK-RECORDER.

69.28.111.6

WAVE

Calculate

Plays back the conversation. The status of the play icon varies depending on the status of the conversation, or it can be

completely missing if the user has no playback right. For further information, see the Playing back recorded conversations

section.

Downloads the media file. This icon is only displayed if the user has the download right and playback is enabled.

Sends an e-mail containing a URL, which points directly to the conversation detail page of the selected conversation. Thisicon is

only displayed if the user has the e-mail right and the conversation has a media file.

Silent monitors the call. The full user right has to be set to access this functionality.
Deletes the conversation. The full user right has to be set to access this functionality.

Gets the URL pointing to this conversation. The URL is automatically copied to the clipboard of the client.



Adding metadata

This powerful function of the Verba System provides great benefits for enterprises by allowing the enrichment of technical information
with related business information and conversation content-related data.

This makes searching far easier and enriches reporting, thereby can support complex and sophisticated business processes and workflows
as well as improving process and service quality of the organization.

A few attributes attached to a conversation can help a lot with finding the conversation later, identifying and managing exceptions, etc. Of
course, in conjunction with these the conventional technical attributes/fields like conversation time, duration, and phone numbers can still
be used to find a conversation in the database.

Several comment templates can be defined, which are fully customizable in line with the needs of the organization as set up by the
administrator.

Configuration

The Metadata Template Configuration item can be accessed from the System menu. To add new metadata template fields or
create entirely new templates, use the options in the top right corner.

When comments are added for the first time to a given conversation, a comment template has to be selected first. The list of available
comment templates is collected from the group settings. If a user is part of a group, all comment templates associated with the given
group are available for commenting.

Once all the comments have been added, press the Save button to store the comments in the database.

If the user is associated with more than one group, they will be able to add comments using any of the available comment fields for those
groups.

Every user who is authorized to view a given conversation will be able to add comments to a conversation. Comments added by a specific
user cannot be modified by another user.

On the conversation list, the mark (blue square) indicates that the comments have been entered to the conversation.

For further information on comment administration, see Comment Template Administration.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816657/Metadata+templates

Conversation participant list

The system keeps track of conference participants.

In the top of the Conversation details window Conversation participants are shown with:

name
role

duration
end cause

start of participation
end of participation

Conversation Details

~ Conversation Participants
Phone Number Name
kirk@enterprise.com
ceo@hoolie.com
skywalker@darkside.com
~ Conversation Details Data
Start Time
Duration
From
From Info
Verba From Party Name
Conversation Identifier
From IP
From Proxy IP
Audio codec
Archived
Source Platform
Conversation Type
End Cause
Storage Target
End of Retention
Platform Conversation ID
Silence Ratio
Longest Silence
Recording failed
Media Eror
Agent ID

From Device ID

» Shared Files

» Metadata and Markers.

User Role
host
conferee

conferes

Jul 22, 2016 5:54:44 PM
00:00:00
team@piedpiper. com

US PiedPiper Team

38041662-501d-1126-80c5-00155d001¢c32
10.40.74

File Share

Normal

kirk@verbatestlocal

Start Time End Time

2016 Jul 22 12:54:44 2016 Jul 22 18:30:44  05:36:00
2016 Jul 22 12:50:44 2016 Jul 22 182544 05:26.00
2016 Jul 22 13:00:44 2016 Jul 22 18:24:44  05:24:00

End Time
Direction

T

3

ToInfo
Verba To Party Name
Recording Server
ToIp

To Proxy IP

Video Codec

Import Source
Forward Reason

File format

Data Management Events
Delete after End of Retention
Technical Identifier

Talkover Ratio

Media Length

To Device ID

Duration

BaBU0%

View Conversation Audit Log
Share/Publish the conversation

Close
End Cause
Normal
Normal
Normal
?
Jul 22, 2016 5:54:44 PM
conference
Conference (KELNPTM1)
TESTMR4
10.40.19
Calculate
No
4826879964654db5a826d1f4a83ar731]1]-1
?

@ Incertain cases, a conference conversation is not stored in the system as a single conversation. For example, if the host is not a
recorded user, only certain participants, then only those parts of the conference will be recorded, when that participant is part of
the conversation. This way each participant can have a record of the part when they were in the conversation. This is sometimes
necessary for security reasons.






Right click options

Every conversation detail page allows for the application of certain filtering options by right clicking on a phone number.

Conversation Details

~ Conversation Participants

No data available

~ Conversation Details Data

Start Time May 30, 2015 5:47:19 PM

Duration 00:01:05
From 1914
FromInfo Michael Cohen

Verba From Party Name Michael Cohen

Conversation Identifier 1945C4B8-13F4-40C2-BFEC-663D20945A6F

From IP

From Proxy IP

Audio codec

Archived No
Source Platform
Conversation Type

End Cause MNormal

Storage Target

End of Retention
Platform Conversation ID
Silence Ratio

Longest Silence
Recording failed

Media Error

Agent ID

From Device ID

» Metadata and Markers

G711 uaw 64k

PIFEBRU®
View Conversation Audit Log

$Share/Publish the conversation
Close

End Time May 30, 2015 5:48:24 PM
Direction PSTN Out
= sem949228
Search List Options
Filter this lst by * 159049228
Filter this list by (in new window) - 159049228
ERVER
Al conversations from/io, same day . 150049228
All conversations from/to, same day (in new window) : 159049228
All conversations from/io, same day - 1 day - 159049228

All conversations from/to, same day +/- 1 day (in new window) : 159049228

Import Source

Forward Reason

File format

WAVE
wi2

Data Management Events Calculate

Delete after End of Retention Mo
Technical dentifier

Talkover Ratio

Media Length

To Device ID

These filtering options are useful when the user would like to find corresponding conversations to a given phone number. The following
table describes the available options:

Option
Filter this list by
Filter this list by (in new
window)
All conversations from/to,

same day

All conversations from/to,
same day (in new window)

All conversations from/to,
same day +/- 1 day

All conversations from/to,
same day +/- 1 day (in new
window)

Description

By applying this option, the current list will be filtered by the number, which was selected by the right click.
The new results will be displayed in the same window.

By applying this option, the current list will be filtered by the number, which was selected by the right click.
The new results will be displayed in a new window.

By applying this option, the current list will be filtered by the number, over which the right click was
initiated, and that date will be used, which was selected by the right click. The new results will be displayed
in the same window.

By applying this option, the current list will be filtered by the number, over which the right click was
initiated, and that date will be used, which was selected by the right click. The new results will be displayed
in a new window.

By applying this option, the current list will be filtered by the number, over which the right click was
initiated, and that date +/- 1 day will be used, which was selected by the right click. The new results will be
displayed in the same window.

By applying this option, the current list will be filtered by the number, over which the right click was
initiated, and that date +/- 1 day will be used, which was selected by the right click. The new results will be
displayed in a new window.

After applying any of these options, the filter settings can be canceled on the top of the new list.



Participant sets

Participant Sets allow users to search for recorded conversations by a predefined list of users or extensions.Overview

Participant sets can be shared with other users via user groups.

User permissions for participant sets

The table below summarizes user level permissions controlling access to participant sets.

Permission Description
Use Participant Set  Allows using participant sets.
Participant Set Grants access to creating or sharing participant sets:

® no access: The user is not allowed to create or share participant sets.
® Define Users: With this permission, the user can create Participant Sets, but can't share them with other users.
® Define & Share: Users with this permission can create and share Participant Sets.

Creating a Participant Set
In order to create a new Participant Set follow these steps:
Step 1 - Login to the web interface with the user who has Participant Set access control and the Define or Define&Share is enabled.

Step 2 - Navigate to the Conversations / Participant Sets menu item and select Add New Participant Set on the top-right corner of the
page.

Step 3 - Name the new Participant Set.

Step 4 - Select one from the available types:

Type Description

1

User Select from the following 'User Lookup Fields":

Display Name

Login

E-mail

Custom User Field 1
Custom User Field 2
Custom User Field 3
Custom User Field 4
Custom User Field 5

Extension  Verba will only match users with extensions.

Step 5 - Provide a brief description to the Participant Set.
Step 6 - With Define access control only continue with step 8. (The access control will be Private)

Step 7 - Select an Access Control. The following Access Controls are available:

Name Description



Private Not shared with anyone. Only the user can see and use this Participant Set.
Selected Users =~ Shared with given users and groups.

Everyone Every user can see and use this Participant Set.

Step 8 - Enter the Participant Set Items. (search criteria, custom field values, extension numbers, etc. )
Step 9 - Hit the save button to see which users/extensions (depending on the type) are included in this new Participant Set.
Sample view of the Participant Set Configuration page:

Participant Set Data

Name' Example participant set

Type User v
User Lookup Fields Display Name | Login [/ E-mail # Custom User Field 1 | Custom User Field 2 () Custom User Field 3 ) Custom User Field 4 [ Custom User Field 5
Example participant set
Description
P
Access Control
Private ® Selected Users ) Everyone
Verba Administrator (Administrator) b
Users
Parﬂ(ipantﬁSetﬁGr?)upﬁZ - Participant_Set_Group_1
Participant_Set_Group_3
Groups | Participant_Set_Group_4
Recorded Users.
Test Group

testiisers
Participant Set Items

test_custom field_1_id_001

test_custom field_1_id_002

test_custom field_1_id_003
test_custom field_1_id_004
‘test_custom field_1_id_005
Ttems* |test_custom field_1_id_00g|

You can enter user names, login IDs or email addresses. Enter each item in 2 new line.

=3

Indicates requirad item.

Using a Participant Set

Step 1 - Navigate to the Conversations page.

Step 2 - The Load Participant Set icon
—

is next to Phone Number (From or To Party) (extension type Participant Set) and User (user type Participant Set) input boxes.
Step 3 - Click on the icon and select the Participant Set to be used.

Step 4 - Hit the Search... button.



Web-based media player and viewer

Overview

The Verba media player and viewer is a feature-rich multimedia tool that supports an easy in-depth analysis of media recordings.
Features include:

Audio and video playback

Full playback control

Volume control

Speed control

Channel (left/right) control

Waveform display

Timeframe selection

Marker creation and management with commenting

The player is available on the Web Application (minimized at the bottom) when a conversation record is selected for playback.
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Browser support
Media Type Format Windows mac0S Linux
Internet Explorer Edge Chrome Firefox Safari Chrome Firefox Chrome
11*
(or IE mode in

Edge)

Audio** Any format Yes 'ﬂ' Yes 'ﬂ' Yes 'ﬂ' Yes a Yes 'ﬂ' Yes 'ﬂ' Yes 'ﬂ' Yes a
silent Monitoring Yes with Verba Codec - - - - - - -
installed

Video Transcoded Yes a Yes ﬂ Yes a Yes o Yes o Yes a Yes o Yes o

video in MP4

Native video in Yes with Verba Codec - - - - - - -

VMF installed
Screen Share Transcoded Yes a Yes o Yes a Yes o Yes o Yes a Yes o Yes o
video in MP4

Native videoin Yes with Verba Codec - - - - - - -

VMF installed 0

Native video in
MSRDP

Firefox

Yes 'ﬂ'

Yes ﬂ

Yes o



Desktop Screen
Capture

Instant Message

SMS

Voice Transcript

File/
Attachment***

Notes:

Transcoded
video in MP4

Native video in
VF

Standard format

Advanced format

Any format

Yes ﬂ

Yes with Verba Codec

installed 'ﬂ'
Yesﬂ

Yes a
Yes 'ﬂ'

Yes ﬂ

ves @
ves @
ves @
ves @

Yes ﬂ

ves @
ves @
ves @
ves @

Yes ﬂ'

ves @
ves @
ves @
ves @

Yes ﬂ

ves @
ves @
ves @
ves @

Yes ﬂ

ves @
ves @
ves @
ves @

Yes ﬂ

ves @
ves @
ves @
ves @

Yes ﬂ'

ves @
ves @
ves @
ves @

Yes ﬂ

ves @
ves @
ves @
ves @

* For Internet Explorer, the audio and video playback works with Windows Media Player ActiveX component which allows using the
Verba Media Codec to playback non-standard formats as well. For other browsers, the audio and video playback works with HTML5 audio
and video capabilities.

** Audio is automatically transcoded to PCM Wave or MP3 on the server-side for playback. For silent monitoring, a network connection is

required with the Recording Server to receive the audio streams in real time.

*** Files are not displayed in the player/viewer, they are automatically downloaded and can be opened on the desktop computer with
corresponding applications

Test whether the required components are properly installed or not, by clicking on the waveform icon left to the Verba Player title in the
top-left corner of the player frame. This test feature is only available when a recorded media file is selected to play from a conversation list.

If one of the required components are not properly installed the test will fail.

Using the player

® Using the media player

® Using conversation markers




Using the media player

After clicking on the play icon of a conversation in the conversation list, the Verba player automatically appears (from the bottom), loads
the media file, and starts playing back the recorded conversation.
The key components of the Verba player are shown here:

Q Conversation View

00:00 00:27

? =0
L (S IR RY NS I TR 1IN AT MM T R
CORU DI IS DISN i NS I I

- Conversation Details

B2 Jul 22, 2016, 5:54:44 PM - Jul 22, 2016, 5:54:44 PM
© 00:04:34.000
& chandler@friends.com (Chandler Bing)

& joey@friends.com (Joey Tribbiani)

O Protected
Private

O important

The playback controls are displayed below the waveform display. Use these controls to adjust the volume level and perform basic playback
tasks such as play, pause, stop, rewind, and fast-forward the audio and video files.

The following table explains the function of each control.

Player Control Icon

Feature Description
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Player
Settings

Begin
Fast
reverse

Stop

Play

Pause

Play
selected

Provides additional settings for the playback, including:

Hiding the markers on the waveform

Showing absolute time instead of relative time on the waveform
Playback speed control

Skipping silence

Hide Markers
Show Absolute Time

Playback Speed -

0.25x

0.5x

0.75x
Mormal {1x)
1.25x

1.5x

2%

[] Skip silence longer than 0 seconds.

The settings set here will be saved, and applied for every subsequent playback
action.

Jumps to the beginning of the media.

Fast reverses, if applicable.

Stops the media playback (and repositions to the beginning).

Starts playing the stopped or paused media.

Pauses the media playback.

Starts playing the selected timeframe.
Select a timeframe by following these steps:
® Move the mouse over the timeline area.
® Press the left mouse button and drag it to left/right to select a timeframe.

® Release the mouse button and the area will be highlighted.



Fast Fast forwards, if applicable.

» forward
End Jumps to the end of the media.
M
Volume Drag the volume bar and move the mouse to the left to decrease or to the right
1) | e— control to increase the volume. The setting set here will be saved, and applied for every
subsequent playback action.
Balance Drag the balance bar and move the mouse to the left to mute the right speaker
Puefi) e—— control or to the right to mute the left speaker(Available using Internet Explorer). *
» Fullscreen = Resizes to full screen. This button is only available when the media type is video.

* Media files recorded in stereo format can be played back from the view of only one of the participants using the Verba special balance
control. The stereo recording has to be enabled in the Verba configuration. For more information, see Verba Deployment Guide.

The playback position can also be changed using the mouse by clicking on the position bar (when the cursor changes to shape) and
dragging it left or right. When the mouse button is released, playback starts automatically.

Controlling the player by keyboard

A subset of the above control features is available as keyboard shortcuts:

Keyboard shortcut  Description

CTRL+Left Move the position bar/playback 1 second back.
CTRL+Right Move the position bar/playback 1 second forward.
CTRL+Space Strop/Pause the playback.

CTRL+Up Increase the playback speed.

CTRL+Down Decrease the playback speed.

CTRL+Page Up Increase volume by 5%.

CTRL+Page Down Decrease volume by 5%.

Waveform display
The waveform display provides a visual representation of the audio volume waveform when playback is initiated from the call list. The

waveform generator supports all kinds of media types which are supported by the Verba system. If stereo media is played back, Verba
generates one waveform for each channel.

Transcoding video files

Video conversation and desktop screen recordings are written into the highly efficient Verba Media Format by default.

Playback of those files requires the Verba Unified Media Codec on the client PC where the user plays back the conversations and using
Internet Explorer.

Follow these steps to transcode and play a conversation from the Verba web interface:


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6815888/Installing+Verba+Unified+Media+Codec

Step 1 - Search for the conversation (Search menu on the top)
Step 2 - Click the Play button on the desired conversation
Step 3 - When the Verba player appears, click on the Transcode tab on the left side of the player

Markers Video [ Screen Transcode

Currently loaded format: VIMF

MFPEG-4 (H.264), Medium Cuality, 512 kbit'sec W

You can convert this video into standard format.

This option will let you play the media file in standard format. The standard format does not require
special codec installed on your computer (any standard Window Media Player can play back this file) and
in most cases it has smaller size then the original formats. For more information, please consult vour
system administrator.

Step 4 - Select the video format, then click "Convert" and wait until the transcoding finishes (it will show the progress)
Step 5 - Click the "Play media file in standard format" link that appears (after this the next searches will play the new format
automatically)

Text-based conversation view

When a text-based recording (Instant Message, SMS) is opened, the layout of the web-based media player is different. There are no
playback controls, and on the left side, the IM conversation can be viewed.

Instant Messaging

Export optiens: Excel| RTF | PDF

- | am sending the file I've talked about eariier
one zec

thanks, | will check it later

ok, thx

have a great day

you too

Export options

The conversation can be exported in XLS, RTF, or PDF format by clicking on the links in the upper right corner of the conversation view.
Attachments

The files sent during the IM conversation can be seen inline with the text messages. These files can be downloaded by clicking on the links
in the conversation view.

Advanced text-based conversation view for Microsoft Teams



When a Microsoft Teams IM recording is opened, a more advanced text-based player opens up that supports the rich media content of the
Teams conversations, like:

Text formatting
Attachments
Emojis

Giphys

Stickers

Other apps

The left side of the player contains the conversation, and the right side of the player contains the channel and participant information. The
player supports infinite scrolling.

Q Conversation View ? - O
Instant Messaging ﬁ. T Conversation Details
. Frank Smith 8:33:22 PM (Edited
Hi team, any news regarding the ticket 54547 Channel created at: 2020 11. 26 17
Show 4 replies Channel name: TeamsExiendedQA/General
@ Mate Kiss 83811 PM (Edited Recorded party: JB Teams Test User teamstesiuser@verba com
The latest report for the QA project
E Performance test report webapp.docx (323.4 KiB) Participants Joined Left
@1 A @ ocavorFenyvesi glenyvesi@verba.com Nov 26, 2020 6PM
. Frank Smith 8:41:18 PM @ cavormoczar moczar@verba.com Nov 26, 2020 6PM
Tomorrow there will be pancake! 5 o2
GV Gabor Vass gaborvass@verba.com Mov 26, 2020 6PM
@ Mate Kiss 5:45:43 PM

A @ anos Bodnar janos bodnar@verba.com Nov 26, 2020 6PM

- ¢
A JB 2 Teams Test User Nov 26, 2020 6PM
- t # teamstestuser2@verba com

-

i - Q JB 3 Teams Teslr User Mov 26, 2020 6PM 57

The following table explains the buttons on the top of the player:

Button  Feature Description
% Load every messages Loads every message for the conversation

Export PDF Exports the entire conversation in PDF format

+]

Showing message replies

If there are replies to a message, the reply thread can be opened by clicking on the Show replies link. With the Hide replies link, the reply
thread can be closed.

. Krisztian Papp 35656 PIV
the meeting has been started
Hide replies
. Krisztian Papp 3:57:04 PM
there are messages here

. Krisztian Papp 3:57:12 PM
end I'll end this meeting

Showing message edit history



The edit history of a message can be opened or closed by clicking on the (Edited) link on the right side of the message box.

Qv Gabor Vass 11:26:23 AM (Edited)
> ,:_...::_:.%._.:.._:_. _ = emoticon
Simple text containing = emaoticon. 11:27:37 AM

& 1

Attachments

The files sent during the IM conversation can be seen inline with the text messages. These files can be downloaded by clicking on the links
in the conversation view.

. Janos Bodnar 1:31°05 P
bunnydoc

W | bunny.docx (13.3 KiB)

Emoticon replies

Emoticon replies are shown on the right side of the message box.

Al Attila lhasz 12:17:12 PM (Edited)
Message reacted to by multiple users
@1 A



Using conversation markers

Markers are powerful tools to support conversation analysis and information sharing. Users can bookmark the recording by adding
markers. A marker is a specific section of a conversation (highlighted in the waveform pane) with related notes. This facilitates
conversation reviews and helps information sharing and collaboration with other users e.g. supervisors or managers.

The following figure illustrates the key elements of the marker information pane:

4~ verba Player

A L ik |
& — 1
Paused
L] [ | » el | N L 4 50% |4 |xl|x1
1. 01:46% - 03:212 ||| G0/ | »|[¥2 Important part
3, - m
+ zh= | |
4. - Il
5. - Il
Available marker controls:
Marker Control Icon Feature Description
I Mark Creates a marker for the timeframe selected in the waveform window.
selected To select a timeframe, follow these steps:
timeframe

ﬁ' Delete

marker
» Play marked
timeframe
£) Play marked
timeframe

continuously

Export
marked
audio
segment

1.01:46% - 03:21 %  Modify
marker

® Move the mouse over the timeline area.

® Press the left mouse button and drag to the left/right to select a timeframe.
® Release the mouse button.

Deletes the marker.
Starts playing the corresponding marked timeframe.

Plays the corresponding marked timeframe repeatedly.

Exports the marked audio segment.

After marking a certain timeframe, the user can modify the starting and ending position of
the marker by clicking on the up/down arrows next to the timeframe starting and ending
time values. The values are incremented or decreased by one second for each click. The
markers can also be repositioned by dragging and moving the left or right border of the

markers in the waveform pane (the mouse cursor changes when the feature is available on
the borders).



The following table summarizes the available controls for saving or adding new markers:

Controllcon Feature Description
] Show/Hide markers  Shows or hides the markers on the waveform pane.
+ Add new marker Add new marker element row. By default, only five positions are displayed.
Save markers Apply all changes for all markers. Saves, modifies or deletes the markers in the database.

After successfully marking a timeframe, other users, who are authorized to play back the given conversation (e.g. group or system
supervisors), can easily review and play back the marked section of the conversation. Markers that were placed by a given user cannot be
modified or deleted by other users. The name of the user that placed the marker is displayed in the marker information tab.

On conversation lists, an M mark indicates that one or more markers have been assigned to the conversation.

Markers can be added with the Verba XML Service too. For more information refer to Adding markers to an ongoing conversation.




Verba Offline Player

Overview

The Verba Player is designed to offer playback of encrypted media files on client computers.

Verba Player — O X

Player Call details Encryption

The supported file formats are:

® _vplb (Verba encrypted files)
® .wav,.spx, .vox, .vmf, .au, .vf, .wmv, .vma, .asf, .pcma, .pcmu, .g722, .g729 (Media files)
Configuring a client PC for encrypted playback

In order to open encrypted media files the certificate with which it was encrypted is required to be installed on the client PC. The certificate
must contain the private key.

® |nstalling a Windows Certificate for the Verba Offline Player

How to open and play an encrypted file
To play an encrypted media:

Step 1 - Login to the Verba Web Interface and find your record using the Search menu



Step 2 - Download the file for local playback by clicking on the Download
%,

icon

LHETGe  ©
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1 Download for local playback i <

A

Step 3 - Start the Verba Player and click on the Open

button on the bottom left corner

Step 4 - Find and select your downloaded media file for playback

Troubleshooting Playback Issues

In case of problems with the Verba Player verify the following:

® Troubleshooting the Verba Offline Player




Installing a Windows Certificate for the Verba Offline Player

Overview

To open encrypted media files, the certificate with which it was previously encrypted needs to be installed on the client PC.

/\ The certificate must contain the private key.

Installing the certificate

Step 1 - Right-click on the certificate which contains the private key and was used to encrypt the media files and select Install PFX.

- Verba_Encrypt_Certificate_With_Private_Key.pfx
iy Type: Persenal Information Exchange

Install PFX [:g
Open
Open with...

Send to p
Cut
Copy

Create shortcut
Delete

Rename

Properties

Step 2 - Select Current User to install the Certificate for only the current user or Local Machine to install the Certificate globally for
every user on the computer.



=% Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network:
connections, A certificate store is the system area where certificates are kept,

Store Location

@ Current User
() Local Machine

To continue, didk Mext,

Cancel

Step 3 - By default, the location is filled in for the current file. A different file can be selected by clicking on the Browse... button.



& % Certificate Import Wizard

File to Import
Spedfy the file you want to import.

File name:
azs\Downloads\Verba_Decrypt_Certificate_With_Private_Key.pf | Browse. ..

Mote: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #£12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates ((P7E)

Microsoft Serialized Certificate Store (L55T)

Mext Cancel

Step 4 - Type in the password for the private key. When the certificate is exported with the private key the wizard asks for a password
to protect the Certificate. Enter that password here.



& L¥ Cerificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password.

Type the password for the private key.

Password;

[ ] Display Password

Import options:

[ Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option.

[ | Mark this key as exportable. This will allow you to back up or transpart your
keys at a later time,

Include all extended properties.

Step 5 - Select the Place all certificates in the following store option, then select Personal.



& b Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate,

() Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:

| Browse...

Cancel

Step 6 - The summary page should look similar to this:

Select Certificate Store

Select the certificate store you want to use,

-
| Enterprise Trust

| Trusted Publishers
1 1 intrizted Certifirates

<

Trusted Root Certification Autharities

| Intermediate Certification Authorities

[] show physical stores




& L¥ Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have spedfied the following settings:

Certificate Store Selected by User JalEEE]

Content PFX

File Mame C:\Playeratest\verba_Decrypt_Certificate_With_Pri
£ >

Finish Cancel

Step 7 - After clicking on the Finish button, a popup informs the user that the import was successful.

Certificate Import Wizard >

o The import was successful,

oK




Troubleshooting the Verba Offline Player

Possible error reasons and solution:

® Could not open encrypted file: decryption certificate is not available: <certificate footprint>:

This error means that the required certificate is not installed on the client computer. The certificate's unique footprint is
printed out to help identify which certificate is missing.

® The program can't start because libsiren.dll is missing from your computer:

When this error message appears, verify that the libsiren.dll is placed next to the verbaplayer.exe. The default installation path
is: "C:\Program Files\Verba Player".

Log files and increasing the log level:

The Verba Offline Player writes its log to the following file:
C:\Users\<Username>\AppData\Local\Verba\log\player.log

It supports command line parameters such as:

* Command Line Parameters:
USAGE:

verbaplayer.exe [-c] [-d[=k]] [-n[=k]] [-s[=k]] [-h] [-i]
Where:
® ¢, --config
Displays Offline Player configuration
® -d[=k], --debug[=K]

Debug mode, sets the log level to k; k=0..7, default is 4

Level Name

1 fatal

2 error

3 warning
4 info

5 debug
6 trace

7 insight

® -n[=k], --numberlogfile[=k]
Sets the number of log files, k>0, default is 5

® s[=k], --sizelogfile[=K]



Sets the size of log files in bytes, k=1000000, default is 50000000
® i, --ignore

The command line window will not show up
® -h,--help

Displays usage information and exits

® Example:

Users can create a shortcut for the executable file and for the shortcut path type: "VerbaPlayer.exe -d=7 -i", the log level will be
the highest without any console popup window.



Sharing and publishing conversations

The recording system provides a secure and traceable way to share recordings among various members of your organization.
Recordings with some important elements can be easily shared with other users or published to all colleagues in the company. The system
differentiates two types of audiences:

® Standard Verba users - conversations shared for standard users, who can access the shared recordings via the standard web
application.

® Publishing server users - these users do not have access to standard Verba Web application, they can use a simplified interface
called the Verba Publishing Server. Through this easy-to-use and simple web interface, these users can easily search and play
published records back without the need to login to the Verba Web application. The Verba Publishing Server can also provide
authentication when certain records have to be published with access control. The Verba Publishing Server users can be created
and maintained in the standard Verba system.

The following articles explain how to use the system:

Sharing conversations
Managing shared items
Accessing shared conversations
Verba Publishing Server




Sharing conversations

Sharing a conversation

To share a conversation recording, the users have to find the related conversation and navigate to the conversation detail page or double
click the conversation, then select the Share/Publish the conversation link on the top right corner of the page. The option is only

available for users with Share Conversations rights.

Share Conversation

Sharing Data

Title

Description

Expires On Never expires
Audience* = Selected Users/Groups
Users

Administration Group

All Regulated Users
Customer Services Group
Default

Global Compliance Office
Global Dynamics

Groups

Allow Download

Allow Linking and Embedding

* Indicates required item.

The following table describes each of the available fields:

Field Description
Name
Title Title for the shared recording.

Description = Description of the shared recording.

Requirements

Maximum
length: 64

Maximum
length: 512



Audience The type of the audience can be selected here. The following valid values apply: Required field.

® Selected Users/Groups - this option will provide access to the shared record for selected users or
group of users defined in the Verba System. These users can be standard or publishing server users
as well. After selecting this option, users can define the desired users and/or groups in the multi-
select boxes below. Only those selected standard users can access the shared recording, who have
Access to Shared Calls right. This restriction does not apply to publishing server users. Publishing
server users can access the shared recordings via the Verba Publishing Server interface only after
authentication.

® Allstandard users - this option provides access to the shared recording for all existing and all
future users of the standard Verba system. Only those users can access the shared recording, who
have Access to Shared Calls right.

® All Publishing Server users - this option provides access to the shared recording for all existing
and future publishing server users. Publishing server users can access the shared recordings via
the Verba Publishing Server interface only after authentication.

® Allstandard and Publishing Server users - this option provides access to the shared recording
for both of the above-mentioned user types.

® Public - this option provides access to the shared recording for anyone through the Verba
Publishing Server without authentication.

Users If the audience is Selected Users/Groups, this option enables to select the desired users. Click on the -
desired user(s) in the left box and click on the >> button to select the users. Remove the user(s) by the
clicking on them in the right box and pressing the << button.

Groups If the audience is Selected Users/Groups, this option enables to select the desired groups. Clickonthe -
desired group(s) in the left box and click on the >> button to select the groups. Remove the group(s) by
the clicking on them in the right box and pressing the << button.

Allow If this option is enabled, the recording can be shared from the Verba Publishing Server user interface. It -
direct allows to link directly to the published recording from a 3rd party application or embed a Windows

linking of Media Player object to any HTML page pointing to the shared record. Published recordings shared in
theitemto thisway do not provide any access control.

the

Publishing

Server

Fill in the form and press the Save button to store the sharing information to the database.



Managing shared items

Modifying, deleting and deactivating shared conversations

Already shared conversations can be modified, deleted or deactivated through the Sharing / Manage Shared Items menu item.

Manage Shared ltems

Title v beginswith v ?

Active ©  Title Description Duration = Sharing Date Audience Views ©  Downloads

ade when a customer complained about a service outage and how professionally the service agent May 5,2017 10:42.11 Al standard

000137 0 0
A
an <t Pract rates how an insurance is old 0 a new customer (in-Surance). It can be used as a template for new May 5, 2017 10:36:28
Yes g i 000213 Y 0 0
sales A
May 10, 2016 1:26:4
v Publc Video v3.m T rates 00:03: v 102 © pusic 0 0
A
May 10, 2016 1:26:4
Yes Publc Video v1.wmy This publc video demonsrates why 42 i the answer. onozgs WA 102OTBO gy 0 0
May 10, 2016 12540
v Public Video v2umv This public video demonsirates the weak points of the Death Star. 00:023 0. 201612540 pyy 0 0
May 10, 2016 1:25:40
This public video demonsirates that you can publish videos recorded by Verba. 00025 V10,2018 12540 pypic 0 0

A

After selecting the menu item, click on the desired row and the system navigates to the Share conversations page, where the existing
sharing information can be modified. Simply press the Save button after finishing the modifications.

The shared item can be also deactivated on this page by pressing the Deactivate button. Once a shared item is deactivated, it will no
longer be available for the target audience. A deactivated item can be reactivated anytime later.

The shared item can be deleted by pressing the Delete button. After deleting the shared item, the target audience will no longer be able to

access the sharing. The original conversation recording will NOT be deleted by this action, this operation only removes the sharing
attributes from the original conversation record.



Accessing shared conversations

Users with Access to Shared Conversations right can list and view shared recordings under the Sharing [ View Shared Items menu item.

Shared Items

Title v beginswith v Find ?
Title Description Duration Sharing Date Publisher
Sk of In Surance Best Practce sales ;zzotf"rg‘e'samn demonstrates how an insurance is sold to a new customer (In-Surance). It can be used as a template for new sales J— vA.‘.iv 5,2017 103628 Adminator

8 items found, displaying allitems

Export options: Excel| RTF| PDF

All control buttons like play, download, etc. are available based on the user rights for the shared conversations, just like for normal
recordings.

The following table describes each of the available columns in the list:

Field Description

Title Title of the shared recording.

Description Description of the shared recording.
Duration Length of the shared recording.

File Size File size of the shared recording.
Publisher Name of the user shared the recording.

Sharing Date Date and time of the sharing.
Views Overall number of attempts to view the shared recording.
Downloads Overall number of attempts to download the shared recording.

Audience Defined target audience.



Verba Publishing Server

The Verba Publishing Server provides a convenient, easy-to-use simple interface to access published recordings. The Verba Publishing
Server can be accessed through a web browser. The following HTTP address must be typed in the address field:

http://ServerNameorlPAddress/verba/pub

After entering the URL, all the recordings made available to the public are displayed automatically. To access published calls for a certain
publishing server users only, log in to the Verba Publishing Server first. For more information, please read the topics below.

Recorded Media
Title |z| begins with |z|
No active query. Please enter your search criteria using the options above.
3 items found, displaying all items. Page(s): 1
I N o - (e
Publishing and Sharing 2?;*;122 ?: ;:slns'ra Administrator szg'
Bytes 3:04:05
Duration: 00:00:04 Administrator  Jun 2, 1 1
File Size: 16,606,264 2010
Bytes 3:03:10
Duration: 00:24:07 Administrator  Jun 2, 1 1]
File Size: 4,701,592 2010
t nn , and a commitmer arch and  BYEes 2;52:15
3 items found, displaying all items. Page(s): 1
Export options: Excal | PDF | RTF
(c) Copyright Verba Technologies, LLC. 2000-2010. All rights reserved.
The following table describes the available columns in the list:
Field Description
Title and Description Title and description of the shared recording.
Media Duration and the file size of the shared recording.

Access the Play, Download and Share functions as well.
Publisher Name of the user who shared the recording.
Creation Date Date and time of the sharing.

Views Total number of attempts to view the shared recording.



Downloads Total number of attempts to download the shared recording.

Login to the Verba Publishing Server

To access published conversations for a certain publishing server users only, log in to the Verba Publishing Server first. After accessing the
interface, click on the Login link on the top right corner of the page.

Publishing Server

Login ID:

Password:

The software is licensed to: Verba Technologies
Serial Number: MNRHQ4DK-OO5WDFLO-GE7QOX5K41
Version: 5.0.0281

on any other medium except as = ifi agreement. No
this publication may be reproduced, stored in al system, or transmittad in
m or by any means, ic, mechan cording, otherwise,

In the Login ID field type the user account name (not case sensitive) and enter the corresponding password in the Password (case
sensitive) field, then press the Login button.

Users without a login name and password must contact their system administrator.

If the credentials entered are not valid, the login page is displayed again with the Wrong login credentials! error message.
After a successful login attempt, all shared/published recordings will be displayed, which are made available for the given user.
Users can log out anytime by clicking on the Logout link in the top-right corner of the page.

The system also allows users modify their password. Simply click on the Change Password link in the top right corner and fill in the form.



Using the Cisco IP phone service

Many convenient features of the Verba System are available from Cisco IP phones.

The following functions are available for XML-capable Cisco IP phone users:

® On-Demand recording capability for those extensions where this recording mode is configured in the Verba system. Users can
select the current conversation to be recorded through an XML-capable Cisco IP phone. For users with extensions constantly
monitored and recorded the on-demand conversation recording function is not applicable.
Regardless, when the user marks the conversation for recording during the conversation, the entire conversation will be recorded
(not only from the point of recording request).

® Silent monitoring and whisper coaching features allow supervisors to silent monitor and/or whisper coach agents using their
Cisco IP phones. The same feature is available on the web interface, see Silent monitoring ongoing conversations.

® Conversation tagging allows the user to assign a tag to an ongoing conversation or to an already recorded one. Users can assign
(add) a tag to a conversation by selecting it from a predefined list of values (configurable) using the screen of the IP phone. Only
those users are able to tag their conversations who have the commenting right. For more information about rights visit User rights.

® Adding markers to an ongoing conversation (Bookmark). These markers are displayed in the Verba Player during playback to
support call analysis and information sharing. For more information see Markers on page.

® Flagging a conversation as Private. Users can flag both ongoing and already completed recorded conversations as private from
their phone in addition to doing it through the web-based interface. Private conversations can be played back only by the
participants of the conversation. For detailed information see Private conversations and User rights.

® Flagging a conversation as Important. Conversations flagged as important can be listed directly through the Conversations /
Important conversations menu item on the web interface. More information is available in the Important conversations section.

® Sending an email with a link pointing to a URL. This provides direct access to the conversation (conversation detail page) for the
recipient the conversation is "one click away". Authentication is performed before allowing access to the conversation.

In order to provide access to the Verba Phone service for the user, the system administrator needs to configure the Verba Phone Service for
the user's Cisco IP phone device (for details check Configuring the Cisco IP Phone service).

Supported Cisco IP phone models: every XML capable phone.

The Verba Phone Service provides access to certain functions of the XML service by a single button click (only available if Verba is used
without authentication). This access method provides features for ongoing conversations only.

Adding a tag to a conversation

Adding markers to an ongoing conversation

Flagging a conversation as Important

Flagging a conversation as private

Login to the Verba Phone service

Recording an ongoing conversation or the most recent conversation

Sending emails
Silent monitoring and whisper coaching



https://verbalabs.atlassian.net/wiki/pages/createpage.action?spaceKey=docs&title=User%20rights%20%28Verba%207%20and%20below%29&linkCreation=true&fromPageId=6816892
https://verbalabs.atlassian.net/wiki/pages/createpage.action?spaceKey=docs&title=User%20rights%20%28Verba%207%20and%20below%29&linkCreation=true&fromPageId=6816892
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6818491/Important+conversations
https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6815946/Configuring+the+Cisco+IP+Phone+Service

Adding a tag to a conversation

This function allows the user to assign a tag to an ongoing conversation or to an already recorded one. Users can assign (add/change
/delete) a tag to a conversation by selecting it from a predefined list of values (configurable) using the screen of the IP phone. To add a
comment tag to a conversation (tagging) through the Verba Phone Service, follow these steps:

Step 1 Press the Services button on the phone or select the proper menu item.
Step 2 Select the Verba Phone Service.
W10 57 03/04/16
& Services
‘Extension Mobility

Select Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.

Step 4 Details about the ongoing conversation (associated with the user) are displayed.
To add a tag to the ongoing conversation press the AddTag button
To add a tag to the most recently completed conversation press the Other button then the Last button, and finally the AddTag button.

To add a tag to any previously recorded conversation, press Other followed by the Calls button, then select the desired item by pressing
the Select button and finally press the AddTag button.

The AddTag button is only displayed if the user has the right to add a comment. The service checks the user's right. If the given username
is valid and the user is granted the commenting right, then the button is displayed.

(“ W09 22 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:25:43 AM
Direction: Internal

Make a selection...

[—[—[—[—[—

If there is no conversation in progress then the following screen is displayed:




W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...

Step 5 After pressing the AddTag button a predefined list of tags (labels) are displayed. Choose the desired comment label by pressing the
appropriate number on the touch pad of the IP phone or the Select soft-key. If more than five labels are available, scroll the list by using
the navigation button on the phone.

{50 09:29 03/07/16
& Add Tag to the call

[ETechnical
i‘Marketing

!Suppor‘t

Y IEceneral

Make a selection...

_ Back | Select

Step 6 After selecting the appropriate tag, the user is informed that the comment has been saved.

[*I09:29 03/07/16
& Tag Added
The selected tag has been added to the call.

Make a selection...

Step 7 To remove the assigned tag from the given conversation, navigate to the detailed conversation page of the given conversation then
press the AddTag button. On the list of displayed items an asterisk (*) marks the currently assigned item. Just press the Delete button to
remove the tag from the conversation.



[“09:30 03/07/16

Y I ceneral

Make a selection...

After attaching a flag, tag or comment to a conversation, users can search for this conversation by using the proper fields and text in the
search criteria. The addition of comments through the service can only be done when the conversation is active. Comments may be added
or removed after finishing the conversation from the web-based user interface or select the last twenty conversations from the service on
the phone. For further information, see Adding a tag to a conversation.

The comment texts are added to the comment field (named IP Phone Service XML List) of the comment template in the default group of
the given user. This is a built-in comment field, which is unique in every comment template.



Adding markers to an ongoing conversation

In order to add a marker to an ongoing conversation through Verba Phone Service, follow the steps below:
Step 1 Click on the Services button on the phone or select the full menu item during the conversation.
Step 2 Select the Verba Phone Service.

(W10 57 03/04/16
Q_Sewices

j‘Extensinn Mobility

Aelect Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.

Step 4 Details about the ongoing conversation (linked to the user) are displayed. Press the BookMrk button. A maximum five
markers can be added to a single conversation. Each marker will cover a timeframe starting from (pressing the time " " for 4 seconds)
to (pressing the time "+" for 4 seconds).

(“ W09 22 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:25:43 AM
Direction: Internal

Make a selection...

If there is no conversation in progress then the following screen is displayed:



W09 23 03/07/16
& Current Call

Mo call in progress.

hMake a selection...
Refresh | Calls | Ongoing | Last | Exit _

Step 5 After adding a marker to the ongoing conversation, the user is informed about the success of the operation.

W09 37 03/07/16
& Marker Added

A new marker was added to the current call.

Make a selection...

After adding one or more marker(s) to the conversation, users are able to display the marked timeframe in Verba player. For more
information, see Markers.


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6817008/Add+Marker

Flagging a conversation as Important

To flag a conversation as important through the Verba Phone Service, follow these steps:
Step 1 Click on the Services button on the phone or select the proper menu item.
Step 2 Select the Verba Phone Service.

W10 57 03/04/16

& Services
:‘Extensinn Mobility

Aelect Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.
Step 4 Details about the ongoing conversation (linked to the user) are displayed.

To flag the ongoing conversation as Important press the Important button.

To flag the most recently completed conversation as important press the Other > Last, and then the Important button.

To flag any previously recorded conversation as important, press the Other > Conversations buttons, then select the desired item by
pressing the Select button and then press the Important button.

The Important button is only displayed if the user has the right to flag a call as important and to add a comment.

[“IW09 22 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:25:43 AM
Direction: Internal

Make a selection... -

If there is no call in progress, the following screen is displayed:




W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...

[—[—[—[—[—

Step 5 After successfully flagging a conversation, the user is informed that the conversation has been flagged as important.

(“ W09 41 03/07/16

« Flagged as Important
The call has been flagged as Important.

Make a selection...

Step 6 To remove the important flag from the conversation, navigate to the detailed conversation page of the given conversation. A
new status line shows that the given conversation has already been flagged as important. To remove the "Important" flag, press the
Dellmpt button.

[(“I09:42 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:32:41 AM
Direction: Internal

Important

Make a selection...

[—[—I—[—[—




[ 09:43 03/07/16
&' Removed

The Important flag was removed.

Make a selection...

After flagging a conversation as important, the conversation can be listed through the Conversations / Important conversations menu
item on the web interface. The Verba Web Application also has the important conversation flagging function, see Important conversations.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6818491/Important+conversations

Flagging a conversation as private

To flag a conversation as "Private" using the Verba Phone Service, follow these steps:
Step 1 Press the Services button on the phone or select the proper menu item.
Step 2 Select the Verba Phone Service.

W10 57 03/04/16

& Services
:‘Extensinn Mobility

Aelect Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.

Step 4 Details about the ongoing conversation (linked to the user) are displayed.
To flag the ongoing conversation as private press the Private button.
To flag the most recently completed conversation as private press the Other > Last, and then the Private button.

To flag any previously recorded conversation as private, press the Other > Calls buttons, then select the desired item by pressing the
Select button and finally press the Private button.

The Private button is only displayed if the user has the right to flag conversation as private. The service checks the user right through the
username that was configured for the service (or added through the login process). If the given username is valid, the button is displayed
for users having the private right.

[FIW09 22 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:25:43 AM
Direction: Internal

Make a selection...




W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...

[—[—[—[—[—

Step 5 After successfully flagging a conversation, the user is informed that the conversation has been flagged as private.

(“ W 09:53 03/07/16
« Flagged as Private
The call has been flagged as Private.

Make a selection...

Step 6 To remove the private flag from the conversation, navigate to the detailed conversation page of the given conversation. A new
status line shows that the given conversation has been already flagged as private. To remove the private flag, press the DelPriv
button.

[* W09 54 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:55:34 AM
Direction: Internal

Private

Make a selection...

{—[—[—[—[—




W09 54 03/07/16
&' Removed

The Private flag was removed.

Make a selection...

After flagging a conversation as private, the conversation can be listed through the Conversations / Private conversations menu item on

the web interface. Private conversations can only be played back by the participants of the conversation. Conversations can be flagged as
Private using the Verba Web Application, see Private conversations.




Login to the Verba Phone service

The Verba Phone Service is available in two variations: with authentication and without authentication. When authentication is used, users
have to login to the service using their credentials in order to access its functions.

To login to the service, follow these steps:
Step 1 Press the Services button on the phone or select the proper menu item.

Step 2 Select the Verba Phone Service.

W10 57 03/04/16
& Services

.‘Extension Mobility

Select Service...

_ Select e L

Step 3 The login screen is displayed, where you have to enter the Verba login name and password.

W11 33 03/04/16
& Verba Login

Make a selection...

Step 4 Use the phone keypad to input the Verba username and password, then press the Login button.

Step 5 After successful login the current conversation page is displayed. If incorrect login information is provided, the login page is
displayed again.



[“W09 22 03/07/16

& Current Call

Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 9:25:43 AM
Direction: Internal

Make a selection...

Step 6 If there is no conversation in progress, the following screen is displayed:

W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...




Recording an ongoing conversation or the most recent
conversation

To record an ongoing conversation (or recover and store the most recently completed conversation) through the Verba Phone Service,
follow these steps:

Step 1 Press the Services button on the phone or select the proper menu item.
Step 2 Select the Verba Phone Service.
W10 57 03/04/16
& Services
‘Extension Mobility

Select Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.

Step 4 Details about the ongoing conversation (associated with the user) are displayed. Press the Record button to record the
ongoing conversation for recording. To record the most recently completed conversations, press the Other button and the Last
button, then press the Record button.

[“10:03 03/07/16

& Current Call

Caller: #2409 (John Doe)

Called: #2424

Start: Mar ¥, 2016 10:06:54 AM
Direction: Internal

Status: not marked for recording yet

Make a selection...

[—[—I—[—[—

If there is no conversation in progress the following screen appears:



W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...

Step 5 After successfully denoting a conversation for recording, the user is informed about that the conversation is being recorded.

10 04 03/07/16
& Recording

¥Your current call has been marked for recording.

Make a selection...

When the Back button is pressed, the conversation detail page is displayed again, and a new status line appears showing the conversation
status as "being recorded".

[* 3 10:05 03/07/16

& Current Call
Caller: #2409 (John Doe)
Called: #2424

Start: Mar 7, 2016 10:06:54 AM
Direction: Internal
Status: being recorded

Make a selection...

When a user initiates conversation recording in the middle of a conversation, the whole length of the conversation is recorded. It is
achieved by recording all conversations for extensions, where on-demand recording mode is set, and deleting those which were not
denoted by the user to be recorded (kept).

For further information, see Verba Storage Management Service in Verba Deployment Guide, On-demand Recording Settings topic.



https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6818540/Storage+management+settings

Sending emails

In order to send an email containing a URL that points to the conversation, follow these steps:
Step 1 Press the Services button on the phone or select the proper menu item.
Step 2 Select the Verba Phone Service.
W10 57 03/04/16
& Services
:‘Extensinn Mobility

Aelect Service...

Step 3 If the service is only accessible through authentication, follow the steps described in Login to the Verba service.

Step 4 Details about the ongoing conversation (linked to the user) are displayed.

To send an e-mail about the ongoing conversation, press the Email button and then the To Me button (to send in e-mail to yourself) or the
To Suprv button (to send an e-mail to the default group supervisor(s)).

To send an e-mail about the most recently completed conversation, press the Other > Last > and the Email and then the To Me button (to
send an e-mail to yourself) or the To Suprv button (to send an e-mail to the default group supervisor(s)).

To send an e-mail about a previously recorded conversation, press the Other then the Calls button. Select the desired item by pressing the
Select button then the Email button and then the To Me button (to send an e-mail to yourself) or the To Suprv button (to send an e-mail to
the default group supervisor(s)).

The button is only displayed if the user has the right to send e-mails. The Verba e-mail sending function is interpreted by users. The service
checks the user through the username that was configured for the service (or added through the login process).

[“ I 10:03 03/07/16

& Current Call

Caller: #2409 (John Doe)

Called: #2424

Start: Mar 7, 2016 10:06:54 AM
Direction: Internal

Status: not marked for recording yet

Make a selection...

-

If there is no conversation in progress, the following screen is displayed:



(W09 23 03/07/16
& Current Call

Mo call in progress.

Make a selection...

Step 5 Press the To Me or the To Suprv button to send the email to yourself or to your group supervisor(s) for the given
conversation. The user is informed that the email has been sent. The email address is always collected from the Verba users database
(please, refer to User Administration).

After sending an email, the user receives an email containing an URL pointing to the selected call. By clicking on the URL, the Verba direct
access page is loaded. The user has to login in order to access the call.

Step 6 Open your email application (e.g. Microsoft Outlook).
Step 7 Click on the URL in the email.
Step 8 Login into Verba system with a proper username and password.

Step 9 The system automatically forwards users to the detailed conversation information page of the given conversation record.


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6816663/Users

Silent monitoring and whisper coaching

To silently monitor or whisper coach during an ongoing conversation through the Verba Silent Monitoring Phone Service, follow the steps
below:

Step 1 - Click on the Services button on the phone or select the proper menu item during the conversation.
Step 2 - Select the Verba Silent Monitor Phone Service.
12 32 12/19/14 1304

1304 &=

Conference List’ ™

Conferenceifr

Silent Monitor ™

Your current options -
New Call | Dirfrfr | ConfList | Join | Select

Step 3 - If the service is only accessible through authentication, follow the steps described in topic Login to the Verba service.

Step 4 - On the first screen, enter the extension number and/or the name of the user to be monitored. The system searches for any
occurrences of the provided query strings, so there is no need to enter the full number or name. If these fields are left empty, the
system will display all ongoing conversations based on the access control settings.

=12 36 12/19/14

Make a selection...

Step 5 - Enter the extension number, where the service will deliver the silent monitoring/whisper coaching call.
Step 6 - Press the Search button.

Step 7 - In the ongoing conversation list, select the relevant one. Conversations, where both parties can be monitored, are listed
twice. The number and name in the first row identifies the monitored party in the list.



*12:38 12/19/14

- #1300
-> #1309 1:38:50 PM

Make a selection...

Step 8 - Once an ongoing conversation is selected, press Monitr to start silent monitoring the conversation or Whispr to whisper
coach the user.

W 12:40 12/19/14
« Call

Caller: #1309 *
Called: #1300
Start: Dec 19, 2014 1:338:50 PM

Make a selection...

Step 9 - The silent monitoring/whisper coaching session is presented as a conversation on the supervisor phone. The conversation is
automatically answered. Users can end the conversation anytime like in the case of normal calls.



Desktop recorder user interface

Overview
The Verba Desktop Recorder is responsible for recording screen capture videos on the desktop PCs of contact center agents.

Screen recording starts when a conversation is started on the numbers associated with the agent and recording stops when the
conversation is terminated. The recorded video is automatically uploaded to the Verba Media Repository where it is precisely combined
with the corresponding conversation audio.

The recorder has a minimal user interface on the agent's desktop, designed to ensure the agent is not disturbed during work, but
status assessment and troubleshooting are very easy for the IT team.

Conversation popup panel

mate@verbalabs.com ()

The conversation popup appears at the beginning of the conversation, and the recording can be paused with the pause button. It also
places pause/resume markers at the waveform in the web player.

Taskbar notification icon
The Verba Desktop Recorder presents its current status on the Windows taskbar notification area in the form of anicon.

The following table describes the different icon recorder states:

Icon Description

Idle
V No ongoing screen/audio recording. System is working properly.

V Recording
Screen/Audio recording in progress. System is working properly.

Paused
Screen/Audio recording is paused. System is working properly.

Inactive/Disabled
Screen recording is disabled or inactive. Network or configuration problem.

Error
M Critical error occurred. Desktop recorder is not operational.

(@ Itispossible to disable this icon and make the desktop recorder completely invisible/silent by changing the SilentMode variable
through the Verba administration web interface.



Status messages

Users can get detailed status messages by moving the mouse over the Verba icon in the taskbar notification area.

In the tables below <user> means user names, <extX> means phone extensions.

Normal operational states

Icon status message

Configuring...

Initializing...

Idle username - <ext0>, <ext1>
Inactive - Recording is disabled
Recording <user> - <ext0>, <ext1>

Paused <user> - <ext0>, <ext1>

Error states

Icon status
message

Inactive - Not
connected to
database

Inactive no user -
no extensions

Inactive <user> -
no extensions

Inactive - No
recorders
configured

Inactive - Not
connected to any

recorder

Configuring...

Initializing...

Idle username -
<ext0>, <extl>

Explanation

The desktop recorder is being reconfigured by the Verba node manager.

The desktop recorder is starting up.

Screen recording in progress.

Explanation

SQL Server database connection cannot be
established.

User and phone extension are not configured for
this desktop recorder.

User is configured, but no phone extension is
associated.

No recorder servers are configured. Messages
about conversation start and termination will not
be received.

No recorder servers are available. Messages about
conversation start and termination will not be

received.

The desktop recorder is being reconfigured by the
Verba node manager.

The desktop recorder is starting up.

Everything works properly, the screen recorder is
ready for the next conversation.

Everything works properly, the screen recorder is ready for the next conversation.

Everything works properly, but screen recording is administratively disabled (though e.g. API calls).

Ongoing screen recording is paused (e.g. for PCI DSS compliance reasons).

Possible resolution steps

1. Verify that the SQL Server is available from the desktop
PC

2. Verify the database login credentials configured in the
Verba Media Repository

1. Verify that the user logged into the desktop PC with a
name that is configured for recording in the Verba
Media Repository.

2. Register the user name for recording in the Verba Media
Repository.

1. Verify that the user has an extension associated with it
in the Verba Media Repository.

1. Verify that the recorder servers are properly configured

1. Verify that the recorder servers are properly configured
2. Verify that the recorder serves are accessible from the
desktop PC (firewall issues)



Inactive -
Recording is
disabled

Recording <user>
- <ext0>, <extl>

Paused <user> -
<ext0>, <extl>

Critical Error

Everything works properly, but screen recording is
administratively disabled (though e.g. API calls).

Screen recording in progress.

Ongoing screen recording is paused (e.g. for PCI
DSS compliance reasons).

System is in critical error state from which it can
not go back to normal operation.

1. Try restarting the desktop recorder service

2. Try restarting your PC

3. Try reinstalling your desktop recorder

4. If all these fail, please collect logs and contact support.



Dial-in user interface

Overview

The Verba Recording System provides dial-in services to end-users for the following:

Use case Description Audio conversations Video conversation

Dictation Users can record a dictation with a simple conversation.
Ad-hoc conference Users can add the recorder to any conference call to record it.
Playback Recorded conversations can be played back over the phone.
silent monitoring  Ongoing conversations can be listened to over the phone.

@ Verba Dial-in Services provide audio functions for all PBXs with SIP support, however, video services are limited to certain

vendors. Please contact Verba regarding the latest video recording compatibility.

Dial-in lines

The solution provides different dial-in lines with different capabilities:

playback line - provides playback capabilities for conversation recordings stored in the solution
advanced dial-in line - provides more advanced playback and recording capabilities

Recorder line numbers are configurable. Different customer deployments will have different recorder line numbers.

Authentication

recording line without prompt - recording starts immediately when the recorder answers (but asks for Recorder PIN if required)
recording line with prompt - recording starts after a prompt when the recorder answers (but asks for Recorder PIN if required)

The dial-in services lines are authenticated, functions and content are restricted based on the detected identity. Authentication uses the

following procedure:

1. Detect the caller's phone extension

2. If the extension is configured in Verba and configuration allows PIN-less operation, the service progresses directly
3. If the extension is configured in Verba, but configuration requires PIN, the service progresses after successful PIN authentication

The recorder line does not answer if:

® the caller uses a hidden number
® the extension is not configured in the Verba system,
® dial-in recording is not allowed for that extension

(® PIN-less, extension based authentication is prone to caller ID spoofing.
Use that functionality with care (e.g. for internally accessible dial-in services only).



Dial-in service flows

Click on the diagrams below to see the service flows of the various dial-in lines. Flow and prompt audio customizations can be configured.

Recording line with prompt Playback line Advanced dial-in line

Dial-in interface customization

Audio prompts
Prompts are stored in <PromptPath>\<Language>\ subdirectories.

Language is determined based on authenticated user's language property if available, otherwise based on a configured language default.

File Default Prompt Comment
authfailed.wav Authentication failed!
beep.wav Beep before recording and playback of next

conversation

beepbeep.wav Double beep after the recording ended
enterpin.wav Please enter your PIN code terminated by the # key!
fullmenu.wav To record this conversation press 1, to play back

conversations, press 2, to play back conversations by phone
number press 3!

getplaybacknumber.  Please enter the phone number terminated by the # key!

wav

invalidpin.wav Invalid PIN code!

nocalls.wav There are no conversations available to play back for you "for you" because there is no distinction
between no access for playback and no
conversations found according to searching
criteria

nomorecall.wav No more conversations to play back. To play back the

previous conversation press 4, to enter menu press the * key.

playbackinstructions. To play back an earlier conversation press 4, to play back a
wav consecutive conversation press 6, to enter menu press the *
key.



playbackmenu.wav

recinstructions0.wav

recinstructionsl.wav

resptimeout.wav
sqlerror.wav

welcome.wav

Video prompts

To play back conversations press 1, to play back
conversations by phone number press 2.

Recording will be started after the beep. To stop recording
press the * key, after two beeps recording will be stopped.
You can restart it by pressing the * key again.

Recording will be started after the beep. To stop recording
and enter menu press the * key.

Response timeout.
SQL error.

Welcome to the Verba Recording System.

Recording instructions for recorder line. It's too
long, a shorter prompt is needed is here.

Recording instructions for voice portal

Prompts are stored in <PromptPath> subdirectories. Currently there is no multi-language capability for video prompts.

File Prompt

audioicon.png Thumbnail for audio conversations, used if waveform service, cannot generate waveform

erroricon.png Thumbnail for conversations, that couldn't be opened

verbatech.png  Verba logo showed in bottom right corner of the menus, and full screen for recording with forced duplex streams
(recorder should send audio and video stream, not just receive)

recscreen.png Image for recording screen in 4:3 ratio

recscreen_wide. Image for recording screen in 16:9 ratio

png



Using the Lync 2010, 2013 and Skype for Business extension for
conference call recording

Opening the extension

The extension can be opened from the Lync toolbar. The name of the extension might be different depending on the installation. By
default, it is called Meeting Recorder.

2 Group Conversation (3 Participants) — =

Group Conversation
n informaton d/'_l vieeting Uptons
IM ~ Video ~ Share ~ - 0 =
A |y = g - o3 gl |0 A Always on Top
- i Show Menu Bar
¥ Bajzat Tamas B Ry
- Meeting Recorder
™ Moczar Gabor ] g
# Wolf Attila 5 s Take Motes Using OneNote Ctri+N
© LyncHelp F1
A

Start recording

Once users start the extension, a new panel appears on the right side of the Lync window. It shows the information about the current
conference call. Meeting related metadata is only available if a meeting invite was sent earlier to the recorder. Please contact your system
administrator to get more information about the email address of the recorder service.

Users can start conference call recording by pressing the Start Recording button.



'} | Group Conversation

f‘!; “-\ Jmn\nfgrmanun and Meeting Options (;
R video - smre- g 0
A - a1 ol [ R A -
Bajzat Tamas Sk

® Moczar Gabor Py

Wolf Attila =

Meeting Recorder

Subject:
Meeting ID:
Meeting host:

Start Recording

Need to discuss a few great features of Verba
7002473
Verba Administrator

Manage Recordings

© Verba Technologies, LLC. All rights reserved.

Meeting Recorder x

Refresh

Once users start recording, the system automatically joins the conference call and plays in an audio prompt and sends out a text message
notifying conference participants about the recording. If the announcement service is disabled, no notification will be heard and seen.

Recording can be restarted any time by pressing the Start Recording button again. The system creates separate recordings for each
recording section and assigns the same metadata to each record, so users can easily search for related legs using the subject or meeting ID

during search.

Stop recording

P, { Group Conversation

7~ | Join information and Meeting Options (;
M el - video ~ share - £- 0 >
A E - a4l [ A~
¥ Bajzat Tamas Bk

@ Moczar Gabor Fe
Recording Announcement 5]

Wolf Attila =1

Recording Announcement 17:21

° Dear All,
This meeting is being recorded

Last message received on 2013.11.28, at 17:21.

Meeting Recorder

Subject:
Meeting ID:
Meeting host:

Need to discuss a few great features of Verba
7002473
Verba Administrator

| Stop Recording ’

Manage Recordings

© Verba Technologies, LLC. All rights reserved.

Meeting Recorder %

Refresh

Users can simply stop recording by pressing the Stop Recording button.



Error messages

The following table describes error messages:

Message

Extension/address is not
enabled for recording

No ongoing conference call is
found

Authentication error, token
expired. Requesting new
token...

Recording already started
Recording already stopped

Connection error

Description

The recording system is not configured properly, because the extension/address is not configured for
controlled recording.

The system cannot find any ongoing call for the extension/address. If you do have an ongoing call,
please check the recorder configuration. Click on the Refresh link on the top right corner to retry.

Authentication error occurred when contacting the recording server. The extension automatically tries
to reconnect.

Recording has already been started.

Recording has already been stopped.

Connection error occurred between the extension and the recording server. Click on the Refresh link
at the top right corner to retry.



Agent View

Summary

The Agent View provides contact center supervisors (users with system supervisors and group supervisor rights) that ability, to

® see conversation status of all agents on a single screen
® see agent desktop screens and start monitor sessions.

For the desktop screen functionality, users need to install the Verba Desktop Agent on the PCs of the contact center agents.

Agent View settings

Agent View

Group:  Default v GrdSizer 4X4 ~ [ E [snowldle Screens []Show Available Screens Only ?2 o

On the top of the Agent View, the settings change how the agent information is presented:

Icon Name Function
Group: | Sales x Group Show only the supervised group if the logged in user is System supervisor the
' - selector  drop down contains every group
Grid size: [5%X5] 2 Grid size  This drop down set the size of the current grid. (3x3, 4x4 (default), 5x5)
' = selector

. Enable Turns on the agent screen monitoring and shows the screen thumbnails at
agent every agent (Default: OFF)
screens

| Disable Turns off the agent screen monitoring and hides the thumbnails
agent
screens

Save Stores the previously set options into the database. Next time the user goes to

- settings  the Agent View the saved settings will be loaded

2 Refresh Refreshes the Agent View grid. Refreshes every thumbnail.

Show Idle Screens Show All extensions with enabled Desktop Screen recording is listed (checkbox is
Idle only available if the user has the Agent View Scope permission set to 'On the
Screens  phone' &Idle Screens - for more information check User Roles page.

: ow ow extensions with connected/available desktop on
Show Available Screens Only sh sh i ith d/available desktop only

Available
Screens

The grid view provides the followings:

grid of agents - where each agent is always in the same place for easy follow-up

conversation status and remote party number - Every 5 seconds the grid view updates and shows the conversation status of the
agents. Agents with an ongoing conversation are marked with a red border and shows the number/address of the other party
thumbnail video - by moving the cursor over an agent's thumbnail, it will continuously refresh until the mouse cursor stays over it
initiate monitoring - click on the thumbnail to monitor the agent screen in large resolution


https://verbalabs.atlassian.net/wiki/spaces/docs/pages/6815840/Installing+the+Verba+Desktop+Agent
https://verbalabs.atlassian.net/wiki/display/docs/User+roles

Monitoring the desktop of an agent

By clicking on any of the displayed agents in the Agent View, you can open a monitoring session, which shows a fullscreen view of the
agent's desktop.

The current desktop screen of the agent is streamed into this window in high resolution and keeps refreshing until the view is closed by
clicking on the shaded territory around the stream.

The two arrows on the left and right of the screen let you navigate between the agent's screens real-time.



User Information

The user information page can be reached by clicking on the logged in user in the upper right corner of the Verba web interface, then
selecting the My User menu.

Verba Administrator

My Account
Change Password

[wp  Sign Out

$ on-line Help
On-line Support

Downloads

About

This page provides detailed information about the currently logged in user. It also provides the capability for setting the Language and the
Timezone easily. The Home Page setting provides the ability for defining the default landing page when the user logs in.

User Name  Verba Adrminitrator
Login  Administator

Valid From Jul 23, 2017 64712 PM
Email

Standard User
Superuser

Assigned Roles
Extensions
Groups  Defaut
Observer User
Observer Group
Login Time  Jul 26, 2018 3:56:57 PM
Loggedinsince 2859 minfs
Previous Login Time  Jul 26, 2016 2:30.26 PM
Verba Server 10.4.0.46 (TESTHR4 VERBATESTLOCAL)

User Agent  Mozilll5.0 (Windows NT 10.0; Win64; x64) AppleWebkit537.36 (KHTIL, lie Gecko) Chrome/67.0.3396 99 Safari/537.36
A The changes will be efiective only after you log off and log in again.

Language | English (en)

GMT+01:00 - Europe/Budapest
Timezone

Contal European Tme

e

Home Page
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